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Chapter 1 Introduction 

1-1 DOP-A Series Human Machine Interface 
Thank you for purchasing DELTA’s DOP-A series. DOP-A series are 

manufactured by adopting high-speed hardware to provide you a useful and 
programmable interface.  
  

1-2 Features 

� PLC serial drives support 
We support more over twenty brands, including Delta, Omron, Siemens, 

Mitsubishi, etc. For new PLC, we will provide corresponding communication 
protocol on our website for upgrade to meet your requirement. (All other 
trademarks in this manual are property of their respective companies.) 

 

� Multi-language support for screen editor  

Except Simplified Chinese, traditional Chinese and English these three 
languages, screen editor also provides those fonts that Windows® uses. 
 

� Quick execution and communication macro 

It can handle complicated calculation by executing macro. User can also 
write communication protocol with communication macro command to connect 
specific system via COM port. 
  

� Rapidly USB upload/download  

It will shorten upload/download time by using USB Ver1.1. 
 

� Recipes 

It provides useful recipe editor that is similar to Microsoft excel for user to 
edit recipe easily and input multiple recipes simultaneously (size limit is 64K). 
When downloading multiple recipes at the same time, it can exchange by 
internal memory of HMI. If data has finished editing when downloading, you can 
download recipe individually. 
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� Support two different PLCs connections 

Built-in 2 COM ports to connect two different controllers or two same 
controllers simultaneously. 
 

� Support multiple PLCs connections 

Connecting multiple controllers in serial by using COM2 of RS485. (Note: 
controller should provide RS485 interface)  
 

� On-line Simulation  

After finishing editing, it can simulate on PC by connecting controller to 
see if it is correct. 
 

� Off-line Simulation 

After finishing editing, it can simulate on PC directly (without connecting 
controller) to see if it is correct. 

 

� Using SMC Card to backup data 

It is not necessary to use PC to download by using SMC card to backup or 
insert SMC card to another HMI to copy data. History list and alarm message 
can be also saved in SMC card and user can read these files by card reader for 
collecting data and printing. 

  

� Multiple Security Protection  

It provides passwords to protect designer’s intellectual property rights and 
also for user to set user priority for important component. 

  

1-3 Model number  
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Input Power

DOP A 57 GS T D -          

D: DC
A: AC
Interface Type
T: Touch screen only
K: Touch screen and keypad
Panel Type
GS: STN Gray
CS: STN Color
TC: TFT Color
Panel Size
57: 5.7"
75: 7.5"
10: 10.4"

A: A series ~ USB, RS-232, RS-485, RS-422

Delta Operator Panel

Series

Product name
 

1-4 Caution  

� Operation Environment (temperature and humidity) 

Please operate in following environment to adjust screen brightness and 
contrast for getting the best image. If operating out of the range, LCD may be 
improper display when using for long time. 

Ambient Operating Temperature: 0 ºC to 50 ºC (32 ºF to 122 ºF) 
Relative Humidity: 10% ~ 90%, no condensation allowed 

  

� SMC Card 

SMC card can be used to save and transmit data. Only SMC card that 
formatted by HMI can be used on both HMI and Windows® OS system. (Even it 
can be read/wrote in some format, but fault may occurs due to different format 
among Win95/98/2000/XP versions) 
  

� DO NOT plug/unplug the cable from COM port during operation  

Please turn the power off before plug or unplug the cable. 
 

� Recommend System Requirements 
z Pentium III, 500MHz or greater 
z 256MB RAM 
z Windows® 2000 & 98 
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Chapter 2 Scredit Introduction 

2-1 Scredit Setup 

In this chapter, it will introduce general functions of screen editor with 
windows. User can use it to design what he wants. Detail functions will be 
discussed in following chapters. 
  

� Minimum hardware requirement 
1. 80486 or above PC 
2. 16 MB RAM 
3. 10 MB free hard disk space 
4. VGA or super VGA monitor. Display setting of Windows should be set 

to 256 colors or above. 
5. Windows compatible mouse. 
6. Windows compatible printer.  

 

� Software installation 
To start the Delta HMI Screen Editor setup, please refer to the following 

steps: 
Step 1: Please start-up your computer to Win98/NT/XP/2000 system. (Fig. 

2-1-1) 
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Fig. 2-1-1 open Microsoft Windows 
Step 2: Insert the setup CD into your CD-ROM drive and you can execute 

setup.exe from Windows taskbar by clicking Start > Run. (Fig. 
2-1-2) 

Note: If there are other Windows applications running, close them before 
running Setup. 
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Fig. 2-1-2 execute setup.exe under windows system 

Step 3: After pressing Yes button, system will setup automatically and 
you will get a dialog box. You will get following dialog box to 
choose destination location.  

To select the default directory C: \Program file\Delta\Screen editor\, click 
Next>. Setup will install in the directory indicated in the Destination 
Directory box at the bottom of the dialog box. 
 
To select a directory other than the default directory, click Browse... A 
list of available directories appears. Highlight the desired directory for 
the Delta HMI Screen Editor and click OK, then Next>. 

 
If necessary, click < Back button to take you back through Setup dialog 
boxes one by one. 
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Fig. 2-1-3 Directory for installing Screen editor 
 

Step 4: In this dialog box, you can choose setup language: Traditional 
Chinese, Simplified Chinese or English. And then click Next> to 
get following program folder selection dialog box. 

 

 

Fig. 2-1-4 Language installation 
Step 5: This dialog box displays the progress of copying files while the 

Setup program copies all necessary files into the designated 
directory. (Fig. 2-1-5, Fig. 2-1-6) 
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Fig. 2-1-5 Screen editor installation 

 

Fig. 2-1-6 Finish installing Screen editor 
Step 6: At this time, you have finished completed setup. Please click 

Finish to complete setup. (Fig. 2-1-7) 
 

 

Fig. 2-1-7 Exit installation 



 

 2-6

Step 7: Click OK to allow Setup to restart your computer and finish setup. 
Otherwise, click the radio button to “No, I will restart my 
computer later.” And click OK. You will have to restart your 
computer before you can use the Delta HMI Screen Editor. 

 

2-2 How to Start Scredit 
After setup, you can start Scredit from Windows taskbar, click Start > 

Programs > Delta HMI > Screen Editor. (Refer to figure 2-2-1) 

 
Fig. 2-2-1 

 

Fig. 2-2-2 Start-up display 

When you start Screen editor, 
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1. It will open last file automatically if you check “auto open last file 
automatically” in environment setting. 

2. If you didn’t check “auto open last file automatically” in environment 
setting or you didn’t save last file, it will show basic function as fig. 
2-2-3. 

 
Fig. 2-2-3 Screen without editing file 

After opening new file, you will get Screen editor window as shown in the 
following. (Fig. 2-2-4) 
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Fig. 2-2-4 New file screen for Screen editor 

There are five parts in the following for Screen editor application window. 
 

� Menu bar 
There are nine functions for selection. 

 
� Toolbar  
Toolbar is like those toolbar in Windows® program you can arrange its position 
by yourself. 
 

1. Standard toolbar 

2. Zoom toolbar 

3. Text toolbar 

4. Upper-level planning toolbar 

5. Lower-level planning toolbar 
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Fig. 2-2-5 Move Screen editor toolbar 

 

Fig. 2-2-6 Moves Screen editor toolbar and property table 

Menu bar

Property table

Output 

Standard 

Element 

Zoom toolbar
Text toolbar

Status bar

Element list

Status 

Text toolbar

Element 

Standard 

toolbar 

Zoom toolbar

Property table

Output Menu bar 

Lower-level 

planning toolbar 

Upper-level 

planning 

Upper-level 

planning toolbar

Lower-level 

planning toolbar 
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� Element property table  
It provides property setting for each object. Refer to chapter 3 for detail. 

 
Fig. 2-2-7 Property table 

 
 

Fig. 2-2-8 Property list 

  

 
Fig. 2-2-9 Status 

� Output window 
All editor actions and output message during display compiler will be 

shown here. When compiling, Screen editor will detect error of user 
program automatically. Once error occurs, the correspondent message will 
display in output window. User clicks error message to get error element 
window.  

 
Fig. 2-2-10 Output window 

Work area 
Getting suitable edition area by different HMI type of DOP series. Following is 
edition example (Fig. 2-2-11). 
 

Fig. 2-2-8 

Fig. 2-2-9
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Fig. 2-2-11 The interface for open Screen editor application or create new 

application 

2-3 Menu bar and toolbar 

The tools that screen editor provided for user to edit includes objects, pictures, 
recipes and display tools. Menu toolbar contains pull-down menu options. 

 
 

2-3-1 File 
 

Work area 
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Fig. 2-3-1 File options 

Create a new application 
: Creates a new application by clicking the New 

icon , or choosing File>New as Fig.2-3-2, or using keyboard shortcuts by 

pressing Ctrl + N. 

Application edition

Upload files 

Print function 

Exit Screen editor

Last file path 

Password protect

Export a file 

Download firmware
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Fig. 2-3-2 Choosing from menu bar 

 
Fig. 2-3-3 Choosing from toolbar 

Open new 

create new application
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You will get following dialog box (Fig. 2-3-4) to input application name, screen 
name, screen ID, HMI type and controller brand after opening new application.   

 
Fig. 2-3-4 New application dialog box 

If an application already exists, you will get following dialog box to remind you 
saving application (Fig. 2-3-5) before opening application.  

 
Fig. 2-3-5 Saving dialog box 

Open Old application 
: Open current application by clicking the Open 

icon , or choosing File>Open as Fig.2-3-7, or using keyboard shortcuts by 

pressing Ctrl+O or double-click the application icon in your file system.  
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Fig. 2-3-6 Choosing from menu bar 

 
Fig. 2-3-7 Choosing from toolbar 

Open old application

Open old application
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If other application exists before opening, you will get dialog box as fig. 2-3-5 to 
remind you saving file and then get following dialog (Fig. 2-3-8).   

 

Fig. 2-3-8 Open old application 
Close file 
 

: closes current application by clicking File > Close 
as Fig. 2-3-9.  
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Fig. 2-3-9 Close application 
If application doesn’t save before closing application, you will get saving dialog 
box (Fig. 2-3-10) to remind you saving application. 

 
Fig. 2-3-10 Saving dialog box 

Save file  
: Saving current application into disk with 

extension file DOP by clicking the Save icon , or choosing File > Save as 

Fig.2-3-11, or using keyboard shortcuts by pressing Ctrl + S.  

Close application
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Fig. 2-3-11 Choosing from menu bar 

 
Fig. 2-3-12 Choosing from menu bar 

Save 

Save 
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Save as 
: Saving current application as other application 

by clicking File > Save As (fig. 2-3-13). You will get dialog box as fig. 2-3-14 to 
input application name with extension file DOP. 

 

Fig. 2-3-13 Choosing from menu bar 

 

Fig. 2-3-14 Input application name dialog box 
Export 

: Exporting data to picture format (bmp file) by 

clicking the Export icon  (fig. 2-3-16), or choosing File > Export (Fig.2-3-15), 

or using keyboard shortcuts by pressing Ctrl + E.  

Save as other application
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Fig. 2-3-15 Choosing from menu bar 

 
Fig. 2-3-16 Choosing from toolbar 

Export 

Export
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Fig. 2-3-17 Result of exporting file (bmp file) 
Make SMC Firmware 

: After clicking File > Make SMC Firmware (Fig. 2-3-18) 
to write HMI program into SMC card, you can startup HMI by using SMC card. 
You will get dialog box for choosing to startup from SMC card or HMI after 
inserting SMC card and turn the power on. Please choose to startup from SMC 
card for it. You can use this function to transmit a program to one/more HMIs 
without PC to shorten transmission time. (NOTE: Ensure that card reader has 
been driven by PC and SMC card has inserted into card reader before writing.)  
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Fig. 2-3-18 Choosing from menu bar 

Upload screen and recipe  
: After clicking File > Upload (Fig. 2-3-19), you need 

to input password (the password is the highest priority saved in HMI) to get 
save as dialog box (Fig. 2-3-14). After inputting application name, you will get fig. 
2-3-20 dialog box to start uploading. You can get the progress with progress 
box and stop uploading by clicking Stop button. The file uploaded from HMI will 
be converted to original edition file for user to edit file to avoid losing the 
original edition file.  
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Fig. 2-3-19 Upload screen and recipe from menu bar 

 
Fig. 2-3-20 Upload screen and recipe display 

Upload screen and 
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Upload recipe 
: This function is similar to upload function but it 

can only upload recipe. It also needs password (the highest priority password 
saved in HMI) before uploading.  

 

Fig. 2-3-21 Upload recipe 
Update firmware  

: upgrading HMI firmware or adding function for HMI. 

Upload recipe
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Fig. 2-3-22 Update firmware 
Password Protect 

: You can enable and disable password protect by 
clicking File > Password protect (Fig. 2-3-23). Once you enable password, you 
will get Fig. 2-3-24 and  before “Password Protect”. You will need to input 
password before open DOP file. The password is set by clicking Option > Model 
parameter to get following dialog box (Fig. 2-3-26). If you disable password, you 
will get fig. 2-3-25. 

Update firmware 
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Fig. 2-3-23 Password protection  

 
Fig. 2-3-24 

 
Fig. 2-3-25 

  

Password Protection
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Fig. 2-3-26 Password settings 

Print 

: Print current screen by clicking the Print icon  

(fig. 2-3-28), or choosing File > Print (Fig.2-3-27), or using keyboard shortcuts by 
pressing Ctrl + P. 
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Fig. 2-3-27 Print from menu bar 

 
Fig. 2-3-28 Print from toolbar 

Print 

Print 
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Print Preview 
: Printing preview by clicking File > Print Preview. 

 
Fig. 2-3-29 Print preview 

  

Print Preview
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Fig. 2-3-30 Preview result 

 
Print Setup 

: printer and paper settings. 
 
Last file path  
Last file path: Last four applications. You can open application by clicking their 
path as fig. 2-3-31.  
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Fig. 2-3-31 Last open file path 

Exit 
: Exiting screen editor with saving application by 

clicking File > Exit as fig. 2-3-32. If application isn’t saved before exit, you will 
get fig. 2-3-10 dialog box to remind you saving.  
 

Last open file path
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Fig. 2-3-32 Exit 

2-3-2 EDIT 

 

Fig. 2-4-1 Edition options 
1. Undo 

Exit
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: Undo the last operation. Click the Undo icon  as 

Fig.2-4-3, or choose File > Undo as Fig.2-4-2, or use keyboard shortcuts by 
pressing Ctrl + Z. All actions are recorded in output window. 

 
Fig. 2-4-2 Choosing from menu bar 

Undo
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Fig. 2-4-3 Choosing from toolbar 

2. Redo 

: Redo the undo operation. Click the Redo button  as 

Fig.2-4-5, or choose File > Redo as Fig.2-4-4, or use keyboard shortcuts by 
pressing Ctrl + Y. 

Undo 
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Fig. 2-4-4 Choosing from menu bar 

 
Fig. 2-4-5 Choosing from toolbar 

Redo

Redo



 2-35

3. Cut 
: Deletes the selected element and save it in clipboard to 

paste to other place. Click the Cut button  as Fig.2-4-7, or choose File > Cut 

as Fig.2-4-6, or use keyboard shortcuts by pressing Ctrl + X. 

 
Fig 2-4-6 Choosing from menu bar 

Cut
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Fig. 2-4-7 Choosing from toolbar 

4. Copy 
: Copy the selected element to the clipboard. Click the 

Copy button  as Fig. 2-4-7, or choose File > Copy as Fig. 2-4-8, or use 

keyboard shortcuts by pressing Ctrl + C. 

Cut 
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Fig. 2-4-8 Choosing from menu bar 

 
Fig. 2-4-9 Choosing from toolbar 

Copy 

Copy 
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5. Paste 

: Paste element from clipboard. Click the Paste icon  

as Fig. 2-4-11, or choose File > Paste as Fig. 2-4-10, or use keyboard shortcuts 
by pressing Ctrl + V. 

 
Fig. 2-4-10 Choosing from menu bar 

Paste
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Fig. 2-4-11 Choosing from toolbar 

6. Delete 
: Delete selected element as Fig. 2-4-12. 

Paste 
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Fig. 2-4-12 Delete 

7. Select All 
: it is used to select all elements as fig. 2-4-13. When 

selecting all, the element at the left upper corner will be selected with square 
filled with blue and white border as a base element. Others will be selected with 
square filled with white and black border. The base element is used to align or 
resize.  

Delete 
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Fig. 2-4-13 Choosing from menu bar 

8. Find 
: You can use keyboard shortcuts by pressing Ctrl + F to 

find. You can find element text, read address or write address in current screen 
or all screens as fig. 2-4-14. Once it finds, the element will be shown in the 
output window. You can see this element by clicking in the output window as fig. 
2-4-16. 

Select All
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Fig. 2-4-14 Choosing from menu bar 

 
Fig. 2-4-15 Find dialog box 

Fin
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Fig. 2-4-16 Searched element is selected 

9. Replace 
: It is used to replace text, read address and write 

address in current screen or all screens. The data type could be bit, word or 
dword as fig. 2-4-17. 

Click the element 

that is searched. 

Searched element is 
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Fig. 2-4-17 Choosing from menu bar 

 
Fig. 2-4-18 Replace example 

Find What: 1@D1000

Replace

Replace With: 1@D2000 
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10. Group 
: you can make all the selected elements to a group by 

clicking Edit > Group or clicking icon  as fig. 2-4-20. After grouping, no 

matter how many elements it has, it will be regarded as an element to move 
together but it can’t resize. 

 
Fig. 2-4-19 Choosing from menu bar 
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Fig. 2-4-20 setting to be group 

Ungroup 
: To ungroup element as fig. 2-4-21by clicking Edit > 

Ungroup as fig. 2-4-21 or clicking button  directly as fig. 2-4-22. 

Selected 
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Fig. 2-4-21 Choosing from menu bar 

 
Fig. 2-4-22 Ungroup 

Selected 
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Layer 
: It is used to set element layer and layer will be different 

with creation time. Different layer will affect covered space. You can arrange 

layer by clicking Edit > Layer as fig. 2-4-23 or clicking button  

directly as fig. 2-4-24. 

 
Fig. 2-4-23 Choosing from menu bar 
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Fig. 2-4-24 Layer arrangement 

Align 
: You can align by clicking Edit > Align as Fig. 2-4-25 or 

clicking button  directly as Fig. 2-4-26. You need more than 

two elements to align left/ right/ top/ bottom because it is used base element to 
align.  

Bring to front 

Send to back 

Bring forward

Send backward
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Fig. 2-4-25 Choosing from menu bar 

 
Fig. 2-4-26 Align result 
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Make Same Size 
: you can make elements the same size by clicking Edit > 

Make Same Size as fig. 2-4-27 or clicking icon as fig. 2-4-28 directly. 

 
Fig. 2-4-27 Make same size 
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Fig. 2-4-28 Result of make same size 

Text process 
: it is used to edit text. There will be  before those text 

processes that you used. Besides, you can also set by text toolbar. 

Make the 

same height 

Make the 

same size 

Make the 

same width 
The base 
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Fig. 2-4-29 Text process 

Duplicate 
: Copy one or more elements at the same time. You can 

fill copy number in columns (X) and rows (Y) to get the total copy numbers (X*Y). 
The minimum copy number should be more than 2 because the original element 
is one of the total copy numbers. If you only want to copy in columns or rows, 
you can enable and disable them with checking. The spacing is the interval 
among each element. The address increment is used to place the element you 
copy by horizontal or vertical. The unit can be word or bit. Refer to Fig 2-4-31 
and Fig. 2-4-32 for example. 

Edition items 

Text toolbar 
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Fig. 2-3-30 Multiple duplicate 

 
Fig. 2-4-31 Multiple duplicate example 
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Fig. 2-4-32 Multiple duplicate example 

 
2-3-3 View 

 
Fig. 2-5-1 View options 

You can decide what toolbars/docking windows to display or not. Once you 
click it, it will have icon  in front of it and display on screen. You can also 
arrange these toolbars/docking windows by yourself.  

Docking 
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Fig. 2-5-2 Docking windows 

1. Standard toolbar 

 
Icon Function Description 

 
New Create new application 

 
Open Open old application 

 
Save Save edition application 

 
Export Export an application to BMP format 

 
Undo Undo an action (some can’t be undo) 

 
Redo Redo an action 

 
Cut Cut selected elements 

 
Copy Copy selected elements 

 
Paste Paste the element you copy or cut 

 
Find Find specific text, write address or read address 

 
New screen Create new screen 

 
Open 
screen 

Open old screen 

 
Print 
preview 

Preview print screen 

 
Print Print current application 

 
About 
screen 

Screen editor version 
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Icon Function Description 

editor 
Table 2-5-1 Standard toolbar 

2. Status bar  
Display current edition states 
 
 

 
Fig. 2-5-3 Status bar 
 
3. Text toolbar 

 
Icon Function Description 

 
Text size Display and change text size 

 Font Font 

 
Align left Align text to left 

 
Center to 
page 
horizontall
y 

The space at the right/left sides of text will be 
the same 

 
Align right Align text to right 

 
Align top Align text to top 

 
Center to 
page 
vertically 

The space at the top/bottom sides of text will 
be the same 

 
Align 
bottom 

Align text to bottom 

 
Text color Change text color 

 
Underline Add line under text 

Table 2-5-2 Text toolbar 
 
4. Bitmap toolbar 

 
Icon Function Description 

 
Enlarge a Figure Enlarge selected Figure to element size 

 
Actual Figure size Resize the selected element to actual 

Figure size 

 
Align to left side Align selected element to left side 

Download method 
Mouse coordinate in 

edition area Caps 

Scroll LockNum 

Software 

version



 2-58

 
Icon Function Description 

 
Center to page 
horizontally 

The space at the right/left sides of text will 
be the same 

 
Align to right side Align selected element to right side 

 
Align to top side Align selected element to top side 

 
Center to page 
vertically 

The space at the top/bottom sides of text 
will be the same 

 
Align to bottom 
side 

Align selected element to bottom side 

Table 2-5-4 Bitmap toolbar 
5. Element toolbar 
Toolbar 

 

Icon Function Description 

 
Button 

 
 

Meter 

 
 

Bar 

 
 

Pie 

 
 

Indicator 
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Toolbar 
 

Icon Function Description 
 Data 

display 

 
 Graph 

display 
 

 Input 

 
 

Curve 

 
 

Sampling 

 

 
Alarm 

 
 

Graphic 

 
Table 2-5-5 Elements 

6. Planning toolbar 
A. Upper-level planning toolbar 

 
Icon Function Description 

 
Current text Text on selected element 

 
Current status Current status 

 
Previous 
windows 

Select previous windows 

 
Next windows Select the next windows 

 
Compile Compile current element 

 
Download 
screen data and 

Download screen data and recipe 
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recipe 

 
Download 
screen data 

Download screen data 

 
On-line 
simulation 

Test edition file at PC side and it needs 
to connect to PLC. 

 
Off-line 
simulation 

Test edition file at PC side and it 
doesn’t need to connect to PLC. 

Table 2-5-6 
 
 
 
 
b. Lower-level planning toolbar 

 
Icon Function Description 

 
Group Make all selected elements a group 

 
Ungroup Ungroup elements 

 
Bring to front Bring the selected element to front 

 
Send to back Send the selected element to back 

 
Bring forward Bring the selected element forward 

 
Send backward Send the selected element backward 

 
Align left Align the selected element to left side 

 
Align right Align the selected element to right side 

 
Align top Align the selected element to top side 

 
Align bottom Align the selected element to bottom side 

 
Center to page 
vertically 

The space at the top/bottom sides of text will 
be the same 

 
Center to page 
horizontally 

The space at the right/left sides of text will be 
the same。 

 
Make same width Make the selected elements to be the same 

width with based element 

 
Make same height Make the selected elements to be the same 

height with based element 

 
Make same size Make the selected elements to be the same 

size with based element 
Table 2-5-7 Lower-level planning toolbar 

 
C. Zoom toolbar 

 
Icon Function Description 

 
Zoom 
level 

Let you set a zoom level, including 25%, 50%, 75%, 100%, 
150%, 200% and 300% 
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Zoom in Let you change the magnification level, including 150%, 

200% and 300%. 

 
Zoom 
out 

Let you reduce the magnification level, including 25%, 50% 
and 75%. 

 
1:1 Let you change element size to actual size. 

Table 2-5-8 Zoom toolbar 
7. Properties table 
Refer to chapter 3-1 for detail.  

 
Fig. 2-5-4 Element property table 

8. Output window 
Recording edition actions for tracing error address. 

 
Fig. 2-5-6 Output window 
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Fig. 2-5-7 Output window 

 
Fig. 2-5-8 Output result 

 
Fig. 2-5-9 Error output 

 
9. Zoom in 

 : Let you change the magnification level, including 

150%, 200% and 300%. Refer to Fig. 2-5-10, Fig. 2-5-11, Fig. 2-5-12 and Fig. 
2-5-13 for detail. 
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Fig. 2-5-10 Choosing from menu bar 

 
Fig. 2-5-11 Choosing from toolbar 

Zoom in 

Zoom in 
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Fig. 2-5-12 Zoom level = 100% 

 
Fig. 2-5-13 Zoom level = 150% 

100% 

150% 
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10. Zoom out 

 : Let you reduce the magnification level, including 

25%, 50% and 75%. Refer to Fig. 2-5-14, Fig. 2-5-15 and Fig. 2-5-16 for detail. 

 
Fig. 2-5-14 Choosing from menu bar 

Zoom out 
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Fig. 2-5-15 Before zoon out 

 
Fig. 2-5-16 After zoon out 

75% 
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11. Actual size 

 : Let you change element size to actual size. 

No matter zoom in or zoom out, the zoom level could be 20%, 50%, 75%, 100%, 

150%, 200% and 300%. You can also zoom in/out by clicking icon  or  

directly or selecting directly as Fig. 2-5-17. 

 

Fig. 2-5-17 
 
12. Full screen 

: as Fig. 2-5-18 and Fig. 2-5-19. 

 
Fig. 2-5-18 Before full screen 
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Fig. 2-5-19 Full screen (you can exit by pressing Esc or left button of mouse) 

I/O screen 
: as Fig. 2-5-20 and Fig. 2-5-21. 
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Fig. 2-5-20 Before I/O screen 

 
Fig. 2-5-21 I/O screen (you can exit by pressing Esc or left button of mouse) 
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Grid setup 
: helps user to align elements easily. The grid interval can 

be set as Fig. 2-5-22. 

 

Fig. 2-5-22 Grid setup dialog box 

 
Fig. 2-5-23 Show grid 

2-3-4 Elements 
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Fig. 2-6-1 Element options 

Screen editor provides 11 types of elements and there are lots styles for each 
type. These 11 types include button, meter, bar, pie, indication, data display, 
graph display, input, curve, sampling, alarm, graphic, etc. You can select your 
element from menu bar and drag the size you need as Fig. 2-6-2 and Fig. 2-6-3.  
 

 
Fig. 2-6-2 Drag mouse to set element size 
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Fig. 2-6-3 Element display 

Another method to establish element:  
You can also select your element by clicking right-button of mouse in work area. 
Place your mouse pointer in work area and click right-button to get pop-up 
menu. At this time, you can get the element by clicking left-button. Then you 
only need to drag the size you need and set properties in properties table as fig. 
2-6-4, fig. 2-6-5, fig. 2-6-6 and fig. 2-6-7. Refer to chapter 3 for properties of each 
element. 

 

Click right Click left button 

to select 
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Fig. 2-6-4 Select element from pop-up menu 

 
Fig. 2-6-5 Select element from menu bar 

 

Press left button and 

hold on to drag 
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Fig. 2-6-6 

 
Fig. 2-6-7 

Element movement 
Mouse operation is the same as windows®. When mouse pointer becomes to 

, it can be moved by pressing left button and hold on to move as Fig. 2-6-8, 
Fig. 2-6-9 and Fig. 2-6-10. 
 

Release left button 

to get element 
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Fig. 2-6-8 Pointer will be changed to  
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Fig. 2-6-9 

Press left button and 

hold on to move 
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Fig. 2-6-10 

Modify element width 
You can modify element size by pressing left button and hold on to move when 
mouse pointer changes to  as Fig. 2-6-11, Fig. 2-6-12 and Fig. 2-6-13. 

Release button to 

finish moving 
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Fig. 2-6-11 

 

Fig. 2-6-12 

 pointer 

Press left button and 

hold on to move 
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Fig. 2-6-13 Release to finish modifying width 

Modify element height 
You can modify element height by pressing left button and hold on to move 
when mouse pointer changes to  as Fig. 2-6-14, Fig. 2-6-15 and Fig. 2-6-16. 
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Fig. 2-6-14 

 pointer 
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Fig. 2-6-15 

Press left button 

and hold on to 
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Fig. 2-6-16 

Modify width and height simultaneously (Method 1) 
You can modify element height by pressing left button and hold on to move 
when mouse pointer changes to  as Fig. 2-6-17, Fig. 2-6-18 and Fig. 2-6-19. 

Finish 
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Fig. 2-6-17 

 pointer 
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Fig. 2-6-18 

Press left button and 

hold on to move 
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Fig. 2-6-19 

Modify width and height simultaneously (Method 2) 
You can modify element height by pressing left button and hold on to move 
when mouse pointer changes to  as Fig. 2-6-20, Fig. 2-6-21 and Fig. 2-6-22. 

Finish
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Fig. 2-6-20 

 
Fig. 2-6-21 

 pointer 

Press left button and 

hold on to move 
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Fig. 2-6-22 

Input characters 

You can start to input any characters that windows® accepts at blink  

pointer when mouse pointer is  as Fig. 2-6-23 and Fig. 2-6-24. 

Finish 
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Fig. 2-6-23 

 
Fig. 2-6-24 

When clicking, 

mouse will be  

Input 

Blink  

Text will be 

changed at the 
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Right button of the mouse 
You will find that there is different function in different place when clicking 
right-button as Fig. 2-6-25, Fig. 2-6-26 and Fig. 2-6-27. 

 
Fig. 2-6-25 

Toolbar display
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Fig. 2-6-26 

 
Fig. 2-6-27 

Element selection

Element edition
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2-3-5 Screen 

 
Fig. 2-7-1 Screen options 

If you press close box as Fig. 2-7-2, it will hide current screen without exiting. In 
general application, it will exit current screen by clicking close box and remind 
user to save before exiting. But in screen editor, it only hide current screen NOT 
exit. 

 
Fig. 2-7-2 

1. New screen 

You can click the New screen icon  as Fig.2-7-4, or choose Screen > New 

screen as Fig.2-4-3, or use keyboard shortcuts by pressing Shift+N. And setting 

Click “close box” to 

hide current screen
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in dialog box as Fig. 2-7-5. 

 
Fig. 2-7-3 Choosing from menu bar 

 

New screen 

New screen



 2-93

Fig. 2-7-4 Choosing from toolbar 

 
Fig. 2-7-5 Example for new screen dialog box 

 
2. Open Screen 

Open the screen by clicking the Open screen icon  as Fig.2-7-7, or choose 

Screen > Open screen as Fig.2-7-6, or use keyboard shortcuts by pressing Shift 
+ O. When choosing screen, you can preview screen as Fig. 2-7-8. 

 
Fig. 2-7-6 Choosing from menu bar 

Input screen name 

Open screen
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Fig. 2-7-7 Choosing from toolbar 

 
Fig. 2-7-8 Open screen dialog box 

Open screen
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3. Cut screen 
It is used to cut whole screen. You can execute by choosing Screen > cut 
screen as Fig.2-7-9, or use keyboard shortcuts by pressing Shift + T. (Note: You 
can’t undo the action of cut screen. It is the same as delete screen that screen 
will be lost but it can be pasted to get the same screen.)  

 
Fig. 2-7-9 Choosing from menu bar 

 
Fig. 2-7-10 Cut screen message 

 
4. Copy screen 
You can copy whole screen by clicking Screen > copy screen as Fig.2-7-11, or 
use keyboard shortcuts by pressing Shift + C. 

Cut screen
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Fig. 2-7-11 

 
5. Paste screen 
You can paste screen by clicking Screen > paste screen as Fig.2-7-12, or use 
keyboard shortcuts by pressing Shift + P. All screen setting will be the same as 
original screen after pasting but screen name will be given automatically. 

Copy screen
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Fig. 2-7-12 

 
6. Delete screen 
You can delete screen by clicking Screen > delete screen as Fig.2-7-13, or use 
keyboard shortcuts by pressing Shift + D. (Note: After executing delete screen, 
it can’t be undo. Please consider it carefully before deleting screen.)  

Paste screen
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Fig. 2-7-13 

 
Fig. 2-7-14 Delete message 

 
7. Screen Open Macro 
The Macro that will be executed automatically once opening screen. (refer to 
chapter 4 for detail) 

Delete screen
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Fig. 2-7-15 

 
Fig. 2-7-16 Choosing from docking windows 

Screen Open Macro

Screen open 



 2-100

 
Fig. 2-7-17 Macro edition 

8. Screen Close Macro 
The Macro that will be executed automatically once closing screen. (refer to 
chapter 4 for detail) 
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Fig. 2-7-18 Choosing from menu bar 

 
Fig. 2-7-19 Choosing from docking windows 

Screen Close Macro

Screen Close Macro



 2-102

 
Fig. 2-7-20 Editing Macro 

 
9. Screen Cycle Macro 
The Macro that will be constantly executed once displaying screen. (Macro will 
be executed by cycle time setting) (refer to chapter 4 for detail) 
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Fig. 2-7-21 Choosing from menu bar 

 
Fig. 2-7-22 Choosing from docking windows 

Screen Cycle Macro

Screen Cycle Macro
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Fig. 2-7-23 Macro edition 

10. Auxiliary key 
It can use auxiliary key for each screen as Fig. 2-7-24, Fig. 2-7-25 and Fig. 
2-7-26. 
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Fig. 2-7-24 Choosing from menu bar 

 

Fig. 2-7-25 Auxiliary key 

Auxiliary key

Auxiliary key
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Fig. 2-7-26 Settings for auxiliary key 

The number of auxiliary key for each model to use:  
DOP Model name Number of auxiliary 

key 
DOP-A57GSTD 4 
DOP-A57CSTD 4 
DOP-A75CSTD 5 
DOP-A10TCTD 6 

 
11. Screen property  
In this setting, you can decide to set current screen to sub-screen or not. It also 
can set sub-screen size and delay time of clock Macro as Fig. 2-7-29.  
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Fig. 2-7-27 Choosing from menu bar 

 
Fig. 2-7-28 Choosing from docking windows 

Screen 
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Fig. 2-7-29 Screen property setting 

2-3-6 Tools 

 
Fig. 2-8-1 Tools options 

1. Compile 
It is used to compile edition screen to the format for HMI. If this application is a 
new application, it will remind user to save before compiling. If this application 
has saved or it is an old application, it will compile directly. It will output 
message, including error, to output field during compiling and get object file 
finally. But if there is error, it won’t get object result. You can execute it by 

clicking tools > compile or clicking icon  directly or using keyboard 

shortcuts by pressing Ctrl + F7. Refer to example in Fig. 2-8-4 and Fig. 2-8-5. 

Sub-screen setting 

Delay time 

for macro

You can set following items by checking 
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Fig. 2-8-2 Choosing from menu bar 

 
Fig. 2-8-3 Choosing from toolbar 

Compile

Compile 
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Fig. 2-8-4 Compile example 

 
Fig. 2-8-5 

To show you how 

many errors there are.

All compile progress will be

outputted here. If there is error, it

will show error reason. You can

go to the place that occurs error 

by clicking error message

Compile success
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2. Download screen data and recipe 
You can download screen data and recipe by clicking Tools > Download screen 

data and recipe as Fig. 2-8-7 or clicking icon  directly as Fig. 2-8-8 or using 

keyboard shortcuts by pressing Ctrl + F8. If PC can’t connect to HMI, it will give 
you error message as Fig. 2-8-10 and Fig. 2-8-11. 

 
Fig. 2-8-7 Choosing from menu bar 

Download Screen & Recipe
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Fig. 2-8-8 Choosing from toolbar 

 
Fig. 2-8-9 Start to download (the progress will be from 0 to 100) 

Download 

Screen & Recipe
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Fig. 2-8-10 USB open error 
 

Fig. 2-8-11 There is no data to 
download 

  
3. Download screen data 
It is only used to download screen data. You can execute it by clicking Tools > 

Download screen data as Fig. 2-8-12 or clicking icon  directly as Fig. 2-8-13 

or using keyboard shortcuts by pressing Ctrl + F9. 

 
Fig. 2-8-12 Choosing from menu bar 

Download Screen
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Fig. 2-8-13 Choosing from toolbar 

4. Online simulation 
It is used to simulate DOP series HMI by computer but PC should connect to 
PLC first to drive PLC by PC simulation. Therefore, you can’t execute online 
simulation without connecting PLC. But you can execute offline simulation 
without connecting PLC. You can execute by clicking Tools > Online simulation 

as Fig. 2-8-14 or clicking icon  directly or using keyboard shortcuts by 

pressing Ctrl + F4. You can see simulation display in Fig. 2-8-16. 

Download 
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Fig. 2-8-14 Choosing form menu bar 

 
Fig. 2-8-15 Choosing from toolbar 

Online simulation 

Online 
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Fig. 2-8-16 Online simulation display 

5. Offline simulation 
It is used to test the correction of screen, read/write address and Macro without 
connecting PLC. You can execute by clicking Tools > Offline simulation as Fig. 
2-8-17 or clicking icon  as Fig. 2-8-18 or using keyboard shortcuts by 
pressing Ctrl + F5. The execution display will be Fig. 2-8-16. 

 
Fig. 2-8-17 Choosing from menu bar 

Offline 
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Fig. 2-8-18 Choosing from toolbar 

 
6. Recipe 
Recipe provides controller a convenient parameter input method. You can 
transmit the designated parameter to controller by using HMI recipe after 
finishing editing recipe. Recipe can be set and modified by recipe dialog box 
and it can save and use independently without application. Therefore, recipes 
can be used for all brand models. Before using recipe, you should enable first 
as Fig. 2-8-20. 
 

Offline simulation
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Fig. 2-8-19 Choosing from menu bar 

 

Fig. 2-8-20 Recipe setting dialog box 
 
 

Recipe 
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In Fig. 2-8-20, there are 10 groups and the length for each group is 10 WORDs. 
You can transmit one group to PLC designated address by HMI recipe 
parameter. 
 
7. Download recipe 
Downloads recipe to HMI. What you need to do is click Tools > Download recipe 
to download recipe to HMI. The general extension file is rcp. 

 
Fig. 2-8-21 Recipe setting dialog box 

8. Recipe edition 
Before using this function, you should check to enable this function as 

. If you don’t enable this function, you can’t do this function 
even you download recipe data. 

Address: after you click , you will get input dialog box as 
Fig. 2-8-22 to input start address. (Note: only PLC input format it accepts) 
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Fig. 2-8-22 Input start address of recipe 

 

Length: it is used to set the recipe length. The unit is word and it should be set 
to more than 0. Otherwise, you will get following dialog box as Fig. 
2-8-23. 
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Fig. 2-8-23 

Group: it is used to set group number of recipe. It is convenient for user to use 
recipe by switching. The group number should be set to more than 0. 
Otherwise, you will get following dialog box as Fig. 2-8-24.  

 
Fig. 2-8-24 

Apply: after setting length and group number, you can click “Apply” to execute. 
The total recipe size should be less than 64K due to memory limit. 
(Length X groups should be less than 64 X 1024) If one of them is 0 or 
exceeds limit, you will get warning as Fig. 2-8-23, Fig. 2-8-24 and Fig. 
2-8-25. 

 
Fig. 2-8-25 

Open: you can load recipe by clicking “Open”. The start address isn’t saved in 
the file; therefore all brands’ PLC can use the same recipe. 
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Fig. 2-8-26 

Save: When saving file, the start address won’t be saved. This is for user to use 
the same file in the different PLC brand. 

 
Fig. 2-8-27 

Reset: let edition screen reset to the open status. Refer to Fig. 2-8-28 and Fig. 
2-8-29 for example. 
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Fig. 2-8-28 Edition screen 

 

Fig. 2-8-29 Screen after reset 
Clear: no matter what screen you edit, all data will be cleared to 0 after pressing 

“Clear”, refer to Fig. 2-8-30 and Fig. 2-8-31 for example. 
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Fig. 2-8-30 Edition screen 

 

Fig. 2-8-31 Screen after clear 
Print: it will print edition screen for user to use.  
OK: After inputting, you can click OK to save for transmitting or modifying. (You 
should input address before exiting as Fig. 2-8-32) 
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Fig. 2-8-32 If you don’t set address, this warning dialog will display 

Cancel: It will force to exit after clicking “Cancel” without saving anything. 
Therefore, please consider carefully before clicking it. 
 
2-3-7 Options 

 
Fig. 2-9-1 Options menu 

1. Model parameter  
You can execute it by clicking Options > Model parameter as Fig. 2-9-2. There 
are general and communication for setting. In general setting, you can set 
application name, HMI type, PLC type, default start screen, system control area, 
system status, download setting and priority, etc. In communication setting, 
you can set default PLC ID and communication setting. Refer to following 
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figures for detail. 

 
Fig. 2-9-2 

Model 
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General setting 

 
Fig. 2-9-3 

Application name: it is also file name. 
HMI type: DOP series provides different functions for different HMI. 

 
Fig. 2-9-4 HMI type 

Controller: it is used to set controller you use. 

 
Fig. 2-9-5 PLC setting 

The highest priority password: it is used to set highest priority password (there 
are 8 levels for setting software password) 
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Default start-up priority: it is used to set start-up priority, the highest level is 7 
and the lowest level is 0. 
 
System control area – start address: it is used to set the start address of system 
control. 
 
System control area – length: address length will be different by the function. 
(for example, the length is less than 8 Words when using recipe function). Refer 
to chapter 4 for important HMI parameters. 
 
System status area – start address: it is used to set the start address of system 
status area and it needs to input PLC register address. The register address is a 
continuous data block and the length is 6 words. Refer to chapter 4 for 
important parameters of system status area. 
 
Download setting – USB1.1: it uses USB1.1 to download. 
 
Download setting – PC communication port: it uses PC communication port to 
download. 

 
Fig. 2-9-6 PC communication port 

Delay time for start-up: it is used to set delay time for waiting to start-up PLC. 
The range is 0-255 seconds. 
 
Delay time for clock macro: it is used to set delay time for executing clock 
macro. The range is 100~999ms. 
 
Communication parameter setting 
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Fig. 2-9-7 

Connection setting: it is used to set COM port that used to connect PLC. (DOP 
series can support two different controllers simultaneously.)  

 

Fig. 2-9-8 
Communication port: it is used to set COM port (COM 1 or COM 2) for 
connecting HMI.  
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Fig. 2-9-9 

PLC setting － password: it is used to set PLC password. 
PLC setting － delay time for communication: it is used to set delay time for 
communication. The range is 0 to 255 ms. 
Optimization for reading: it is used to enable optimization function. Refer to the 
right lower corner at Fig. 2-9-3. 
Default PLC ID: If PLC doesn’t set station number, it will use this default setting. 
The range is 0 to 255.  
Communication interface: there are RS232, RS422 and RS485 for your selection. 
The default is RS232. 

 
Fig. 2-9-10 

Data bit: there are 7 Bits or 8 Bits for your selection. 

 
Fig. 2-9-11 

Stop bit: there are 1 Bits or 2 Bits for your selection. 

 
Fig. 2-9-12 

Communication baud rate: there are 4800, 9600, 19200, 38400, 57600 or 115200 
for your selection. 

 
Fig. 2-9-13 

Parity bit: there are None, Odd and Even for your selection. 

 
Fig. 2-9-14 

2. Alarm setup 
You can set alarm by clicking Options > Alarm setup as Fig. 2-9-15. The alarm 
setup should set with element settings. If condition occurs in specific address 
during executing HMI after setting, HMI will display warning dialog box 
automatically. In alarm settings, there are append, delete, modify, OK, cancel 
and close as Fig. 2-9-16. You can set alarm properties after clicking “append” as 
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Fig. 2-9-17. 

 
Fig. 2-9-15 Choosing from menu bar 

 
Fig. 2-9-16 Alarm setup 

Append: append an alarm. 

Alarm setup
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Fig. 2-9-17 Alarm property 

Message: The message used for alarm. 
Display color: The color used for alarm. 
Trigger Mode: it is used to set On/Off for alarm.  
Alarm screen: the screen used for alarm. 
Delete: delete the selected address. 
Modify: modify the selected address properties. 
Scan time (sec.): Setting time to scan. 

Number of records in history buffer: when number of records exceeds the 
setting, it will delete the first record and insert the new record into the last 

address. For example, if the number of records in history buffer is set to 100. 
When you want to insert the 101th record, the first record will be deleted and the 
second record will become to the third record, the third record will become to 

the forth record…and the 100th record will become to 99th record. Therefore, the 
new record will become to 100th record. 

Retentive: enable to save data in SRAM when power loss. (the power supply for 
SRAM when power loss is battery) 
Non-volatile: Enable to save data in SRAM when power is turned off or not. (The 
power of SRAM is battery when power is turned off.) 
 
3. History setup: History buffer setting should be used with sample function. 
Refer to chapter 3 for detail.  
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Fig. 2-9-18 

Append: add a history data. 

 
Fig. 2-9-19 History setup 

History setup
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Fig. 2-9-20 Buffer properties - Timer 

 
Fig. 2-9-21 Buffer properties - PLC 

Read address: it is used to set the address for reading. 
Size: it is used to set the number of continuous word. The range is 1~8. 

 
Fig. 2-9-22 Buffer properties - size 

Sample cycle: it is used to set the interval to read address. If it is triggered by 
PLC, this item will be invalid. The range is 0 to 10000. 
 
Sample point: when record number of points exceeds the setting, it will delete 
the first record and insert the new record into the last address. For example, if 
the number of records in history buffer is set to 100. When you want to insert 
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the 101th record, the first record will be deleted and the second record will 
become to the third record, the third record will become to the forth 
record…and the 100th record will become to 99th record. Therefore, the new 
record will become to 100th record. 
 
Record date and time: to enable this function or not. 
 
Auto stop: continue to record when data is full or not. 
 
Non-volatile: to set retention data in SRAM or not when power loss 
 
Trigger source: trigged by Timer or PLC 
 
OK: save settings and exit 
 
Cancel: exit without saving 
 
Delete: delete a history data in buffer 
 
Modify: modify history data in buffer 
 
 
4. Tag table 
It is used for specific character to replace specific address. For example, if you 
use “OS” to replace PLC’s address 1@Y0. You can only write OS to replace 
address 1@Y0 later. 
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Fig. 2-9-23 Choosing from menu bar 

 
Fig. 2-9-24 Tag table settings 

PLC Memory 

Internal 

Tag Table 
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6. Picture Bank 
User can download different pictures from picture bank to rich screen. The 
formats can be BMP or JPG pictures. 
 

 
Fig. 2-9-25 Select from menu bar 

Picture Bank
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Fig. 2-9-26 Picture bank 

Picture width X picture height X 
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Import 

Select old picture bank or

create new picture bank

Select picture
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Fig. 2-9-27 

 create new picture bank 

 delete picture bank 

 save modified picture into picture bank

 import picture into picture bank 

 export picture from picture bank 

 delete picture from picture bank 

 Inverse color 

 convert to 256 grayscale color 

 mirror horizontal 

 mirror vertical 

 actual size 

 extension 
             
 
7. Text bank 
Input common text into text bank and import text from text bank as necessary.  
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Fig. 2-9-28 Choosing from menu bar 

 
Fig. 2-9-29 Text bank edition 

Text bank 
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Import text

Right-click after selecting 

Press button OK 

after selecting text 
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Fig. 2-9-30 Text example 

 
8. Sub-macro 
It is used to edit sub-macro and be called by other Macro. Refer to chapter 4 for 
detail. 



 2-144

 
Fig. 2-9-31 Choosing from menu bar 

 
Fig. 2-9-32 Sub-macro 

9. Initial macro 
Edits initial macro. It will be executed automatically after HMI is power on. Refer 
to chapter 4 for detail. 
 

Submacro
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Fig. 2-9-33 Select initial macro from menu macro 

10. Background Macro 
Edits Background Macro, refer to chapter 4 for detail. 
 

Initial Macro
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Fig. 2-9-34 Choosing from menu bar 

11. Clock Macro 
After HMI is turned power on, it will execute clock macro by clock setting time. 
Refer to chapter 4 for detail. 

Background Macro
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Fig. 2-9-35 Choosing from menu bar 

 
12. Environment setting 
Setting Environment of Screen editor. 
 

Clock Macro
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Fig. 2-9-36 Choosing from menu bar 

Environment
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Fig. 2-9-37 Environment settings 

System path: it is used to save execution files and .DLL files. Unless necessary, 
do not modify this path. It may cause execution error or can’t find file.  
 
Output path: it is used to save all files generated after compiling. All files that 
generated from online simulation, offline simulation, upload file, download file, 
etc. will be saved here. Unless necessary, do not modify this path. It may cause 
execution error or can’t find file. 
 
Options:  
Toolbars/windows: it is used to check to use toolbars. 
 
Language: there are three languages, including traditional Chinese, simplified 
Chinese and English. 
 
Upload/download setting: it is used to set USB or COM port for 
upload/download. 
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Auto save: it is used to set time to save file automatically. The unit is minutes 
(M). 
 
Auto open: it is used to enable to open last file you edit when open Screen Edit. 
 
2-3-8 Windows 

 
Fig. 2-10-1 Windows options 

1. Close window 
It is used to hide current window, NOT exit current window. If you want to 
display the hidden window, you should use Screen > Open screen. 
 

 
Fig. 2-10-2 Choosing from menu bar 

Close 
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Fig. 2-10-3 Example for closing window – step1 

 
Fig. 2-10-4 Example for closing window – step 2 

There is only one 

screen after 

There are two screens 

before closing 
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2. Close all windows 
It is used to hide all windows, not exit all windows. If you want to display the 
hidden window, you should use Screen > Open screen. 

 
Fig. 2-10-5 Choosing from menu bar 

Close all 
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Fig. 2-10-6 Example before closing windows 

 
Fig. 2-10-7 Example after closing windows 
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3. Next window 
It is used to switch current window to the next window. If current window is the 
last window, it can’t switch. 

 
Fig. 2-10-8 Choosing from menu bar 

Next window
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Fig. 2-10-9 Choosing from toolbar 

 
Fig. 2-10-10 

Next window

Before switching to 

next window 
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Fig. 2-10-11 

4. Previous window 
It is used to switch current window to the previous window. If previous window 
is the last window, it can’t switch. 

After clicking “Next 

window” 
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Fig. 2-10-12 Choosing from menu bar 

 
Fig. 2-10-13 Choosing from toolbar 

Previous window

Previous window
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Fig. 2-10-14 

 
Fig. 2-10-15 

Before switching to 

the previous 

After switching to 

the previous 
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5. Cascade 
Opened screens are arranged in an overlapped pattern as Fig. 2-10-17 and Fig. 
2-10-18.  

 
Fig. 2-10-16 Choosing from menu bar 

Cascade 
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Fig. 2-10-17 Before choosing Cascade 

 
Fig. 2-10-18 After choosing Cascade 

Cascade 
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6. Title Horizontal 
Opened screens are arranged from top to bottom as Fig. 2-10-20 and Fig. 
2-10-21. 
 

 
Fig. 2-10-19 Choosing from menu bar 

Title Horizontal
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Fig. 2-10-20 Before choosing “Title Horizontal” 

 
Fig. 2-10-21 After choosing “Title Horizontal” 
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7. Title Vertical 
Opened screens are arranged from left to right as Fig. 2-10-24. 
 

 
Fig. 2-10-22 Choosing from menu bar 

Title Vertical
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Fig. 2-10-23 Before choosing “Title vertical” 

 
Fig. 2-10-24 After choosing “Title vertical” 



 2-165

8. Windows summary 
All opened screens will display at the bottom of “Windows” pull-down menu. 
Clicking file name directly to switch them. 
 

 
Fig. 2-10-25 Choosing from menu bar 
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Fig. 2-10-26 Clicking Screen_2 to switch 

 
Fig. 2-10-27 Screen_2 window 
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2-3-9 Help 

 
Fig. 2-11-1 Help options 

1. Contents  
Display Delta HMI online help topics. 
 

 
Fig. 2-11-2 Online help 

2. About Screen Editor 
Displays Screen Editor version information. 

 
Fig. 2-11-3 
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Chapter 3 Element Function 

This chapter is for you to know the special function of Screen editor each 
element to meet different requirement before design. 

3-1 How to Choose Element 

There are three methods for choosing element before edition: 
1. Right-click in the work area to get pop-up menu as Fig. 3-1-1. 
2. Choosing from menu bar as Fig. 3-1-2.  
3. Choosing from toolbar as Fig. 3-1-3.  

 
Fig. 3-1-1  

Right-click to get 

pop-up menu 
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Fig. 3-1-2  

 
Fig. 3-1-3 Choosing from toolbar 
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After selecting element, left-click and drag on work area to get the new element 
as shown in the following. 

 
Fig. 3-1-4  

3-2 Button Element 

 
Fig. 3-2-1 Button options  
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Button 
type Macro Read Write Function 

Set Button ON Yes Yes 

After pressing button, the state of the setting 
address will be set to ON. The state will be always 
ON even if release or press again. If there is ON 
Macro, it will be executed simultaneously. 

Reset 
Button OFF Yes Yes 

After pressing button, the state of setting address 
will be set to OFF. The state will be always OFF
even if release or press again. If there is OFF
Macro, it will be executed simultaneously. 

Maintained ON 
OFF Yes Yes 

After pressing button, the state of setting address 
will be set to ON. The state will be OFF when
releasing and be ON when pressing again. If there 
is ON / OFF Macro, it will be executed 
simultaneously. 

Momentary ON 
OFF Yes Yes 

After pressing button, the state of setting address 
will be set to ON and executes ON Macro. It will 
still be ON when releasing. But when you press 
again, it will be OFF and executes OFF Macro. It 
will still be OFF when releasing. 

Multistate No Yes Yes 

There are 1-256 multi-states for setting. You can 
set the execution sequence to the next state or the 
previous state. If setting to the next state, the state 
after state 2 will be state 3. If setting to the 
previous state, the state after state 2 will be state 1.

Set value No No Yes 

After pressing button, You will get “Numeric 
keypad” pop-up dialog box in HMI to input value. 
HMI will transmit this value to the write address of 
element after pressing Enter. 

Set 
constant No No Yes After pressing button, HMI will transmit the 

specific value to write address of element. 

Increment No Yes Yes After pressing button, HMI will add the setting 
constant to write address of element. 

Decrement No Yes Yes After pressing button, HMI will delete the setting 
constant to write address of element. 

Goto 
Screen No No No After pressing button, it will switch to the screen 

you designated.  
Previous 

Main 
Screen 

No No No 
After pressing button, it will back to previous main 
screen.  

 Table 3-2-1 
3-2-1 General Buttons 
 

After pressing these buttons, HMI will transmit ON/OFF signal to PLC. 
There are four types: Set button, Reset button, Maintained and Momentary. 
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Fig. 3-2-2 Button properties 

Button properties: 
1. , : the 

address for executing as following figure. 

   
Input address 

2. , : user can 
select button style and foreground color as following figure. 

State: ▲ next state or 

▼the previous state State is 0 and 

input text will be 

shown after 0. Input text  

Choosing different picture 

to show on button 

There are four styles for 

selection as following 

Click element to 

display property 

You can choose different 

function by requirement 
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    (Invisible button) 
Button style 

 
3. , : edits 

ON/OFF Macro, refer to chapter 4 for detail. 
 
4. , ,

, : sets text, 
text size, font and text color by the setting that windows provides. 
 

5. , : to be 
rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 

  
6. : modifies button character directly without 

re-build button.  

   
Button character 

A. Set: after pressing, the button will be always ON. 
B. Reset: after pressing, the button will be always OFF. 
C. Maintained: after pressing, the button will be ON and it is still 

ON when releasing. But it  will be OFF when pressing again.  
D. Momentary: When pressing the button and hold, this button will 

be ON and it will be OFF after releasing.  
7. : the button will be active after pressing 

longer than setting time to avoid mis-operation.  
 
8. : sets the user priority. Only the priority is 

higher than the setting can use it.  
Example: 

                
State 0: text effect for OFF state   State 1: text effect for ON state 
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ON/OFF button application  
3-2-2 Multistate  
 

The state number will be different by the unit. There are 1-256 states for 
unit WORD, 16 states for unit LSB and 2 states for unit Bit. The unit of read/write 
address will be different by the value unit. If value unit is WORD or LSB, the unit 
of read/write address will be WORD. If value unit is Bit, the unit of read/write 
address will be Bit. It will read by the sequence setting (next state or previous 
state) and write the new value to write address.  

 

 
Fig. 3-2-3 Multistate settings 

Multistate properties: 
1. , : the 

address for executing multistate as following figure. 

State number will be

different by value unit:

Word: 256; LSB:16; BIT:2 

State: ▲ next state or 

▼the previous state State is 0 and 

input text will be 

shown after 0. Input text on button 

Choosing different picture 

to show on button 

There are four styles for 

selection as following

Click element to 

display property 
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Input address 

2. , ,
, : sets text, 

text size, font and text color by the setting that windows provides. 
  

3. , : to be 
rich screen with the pictures from picture bank. Refer to chapter 2 for detail.  

 
4. , : user can 

select element style and foreground color as following figure.  

    (Invisible button) 
element style 

 
5. : the element will be active after pressing 

longer than setting time to avoid mis-operation.  
 
6. : set the user priority. Only the priority is 

higher than setting can use it.  
 
7. : state number of multistate. There are 1-256 

states for unit WORD, 16 states for LSB and 2 states for Bit.  
 
8. : sets next state order (previous state/next 

state).  
Example:  

When unit is LSB (D100.0—D100.1----D100.3-D100.4) 
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S0=D100.0 ON  S1=D100.1 ON  S2=D100.2 ON  S3=D100.3 ON S4=D100.4 ON 

 

Y1       Y2       Y3       Y4      Y5       Y6       Y7  MULTI-VALUE 
Multistate application 

3-2-3 Set Value  
 

After pressing button, you will get pop-up box to input value on HMI. 
When pressing Enter, HMI will send the value to PLC corresponding register. 
User can set the maximum and minimum to input and set to trigger before or 
after inputting. 

  
Fig. 3-2-4 Set value properties 

State is 0 and 

input text will be 

shown after 0. 
Input text on button 

There are four styles for 

selection as following

Choosing to trigger 

after writing or 

before writing 
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Fig. 3-2-5 Set value settings 

Set value properties: 
1. , : the 

address for executing set value as following figure. 

   

Input address 
2. , ,

, : sets text, 
text size, font and text color by the setting that windows provides. 

  
3. , : to be 

rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  
 

Clicks here to get left 

pop-up box  

Value unit

Data format 

Input range 

(maximum/minimum)

Integral/ fractional digitals
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4. , : user can 
select element style and foreground color as following figure. 

    (Invisible button) 
Element style 

 
5. , : User 

can use this setting to trigger PLC after writing or before writing. Note: this 
function can only trigger PLC to be ON. If it needs to trigger again, you 
should set the address to be OFF by yourself. 

  
6. : sets the user priority. Only the priority is 

higher than setting can use it. 
  
7. , : sets the 

value unit and format. 
  
8. , : sets the 

input value range.  
 

9. , : sets input value format.  

Set value properties: 
After pressing button, you will get “Numeric keypad” dialog box on HMI to 

input value to PLC corresponding register D1000.  

          

 
Fig. 3-2-6  

You will get “Numeric

keypad” pop-up dialog box

after pressing button “set

value”. 



 3-12

3-2-4 Set Constant 
After pressing button, HMI will transmit constant to PLC corresponding 

register as following figure. 

  
Fig. 3-2-7 Set constant properties 

  
Fig. 3-2-8 set constant properties 

Set constant properties: 
1. , : the 

address for executing “set constant” as following figure. 

Value unit

Value format 

Setting 

Exit with saving Exit without 

State is 0 and 

input text will be 

shown after 0. 

Choosing to trigger 

after writing or 

before writing 
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Input address 
 

2. , ,
, : sets text, 

text size, font and text color by the setting that windows provides. 
3. , : to be 

rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  

4. , : user can 
select element style and foreground color as following figure. 
  

    (Invisible button) 
element style 

 
5. , : User 

can use this setting to trigger PLC after writing or before writing. Note: this 
function can only trigger PLC to be ON. If it needs to trigger again, you 
should set the address to be OFF by yourself. 

  
6. : sets the user priority. Only the priority is 

higher than setting can use it. 
  

7. , : sets the 

value unit and format. 
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8. : user can preset the constant. 

  
Example: 
After pressing button, HMI will transmit constant to PLC corresponding register 
D1000. 

 
 
3-2-5 Increment/Decrement 
 

After pressing button, HMI will increase/decrease PLC value and write the 
result into PLC corresponding register. If the value after operation exceeds 
maximum, maximum will be saved into address as following figure. 

 

Select different 

position address 

length 
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Fig. 3-2-9 Increment/Decrement properties 

 
Fig. 3-2-10 Increment/Decrement settings 

Change input 

Value unitData format 

Jog Step 

Exit with saving Exit without 

Upper/lower bound 

of input value

There are four styles for 

selection as following 

Sets different 

characters by 

requirement. Refer to 

State is 0 and 

input text will be 

shown after 0. 
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Increment/Decrement properties: 
1. , : the 

address for increment/decrement as following figure. 

   

Input address 
2. , ,

, : sets text, 
text size, font and text color by the setting that windows provides. 
  

3. , : to be 
rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  

4. , : user can 
select element style and foreground color as following figure. 
  

    (Invisible button) 
Element style 

5. : Changes element character directly 
without re-building element as following figure. 
  

 
Element character 

6. : sets the user priority. Only the priority is 
higher than setting can use it. 
  

Example:  
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Adjust D1000 value by pressing buttons +/- 

 
3-2-6 Goto Screen 
  

After pressing button, HMI will change screen to designated screen 
directly. 

  
There are two types for selection:  
1. Change screen: pressing button to change HMI to specific screen. 
  
2. Back to previous screen: pressing button to change HMI to 

previous screen. 
  

 

 
Fig. 3-2-11 Goto screen properties  

Properties: 
1. : Setting the address to execute as 

Change input text 

Select switch 

Enable address to 

execute 

There are four styles for 

selection as following. 
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following figure. 

   
Input address 

2. , ,
, : sets text, 

text size, font and text color by the setting that windows provides. 
  
3. : To lower user priority after changing 

screen as following figure.  

 
Goto screen options 

 
4. , : to be 

rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  
5. , : user can 

select element style and foreground color as following figure. 
  

    (Invisible button) 
 

6. : Changes element character directly 
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without re-building element as following figure. 

 
Element character 

7. : sets the user priority. Only the priority is 
higher than setting can use it. 

  
8. : To designate screen to change. 
  
Example: change to designated screen by different button 
 

 
 

3-2-7 System Function Button  

 

System button options  
 

Button type Macro Read Write Function 

System Date & 
Time  No No No

Setting HMI system time and date 
(year-month-day, 
hours:minutes:seconds) 

Password table 
setup  No No No Setting all password priority  

Enter password No No No HMI provides passwords function 
Contrast & 
Brightness No No No Adjust HMI contrast/brightness  

Low security No No No After pressing button, HMI will the 
password to the lowest level (Level is 
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0).  

System menu No No No After pressing button, HMI will change 
screen to system menu.  

Table 3-2-2 System function button  
System function button 

There are 6 settings for system function and they are System Date & Time, 
Password table setup, Enter password, Contrast & Brightness, Low security 
and back to system menu. 

 

 
Fig. 3-2-12  System function properties  

 
Properties: 
 
1. , ,

, : sets text, 
text size, font and text color by the setting that windows provides. 

  
2. , : to be 

rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  
3. , : user can 

State is 0 and 

input text will be 

shown after 0. 

Change input 

There are four styles for 

selection as following. 

There are six settings for

selection as following. 
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select element style and foreground color as following figure. 
  

    (Invisible button) 
Element style 

4. : Changes element character directly 
without re-building element as following figure. 
  

   
System element settings 

a. System Date & Time  
Provides a button for user to set system data and time of HMI. You 

only need to press SYS button to enter HMI system setting screen as 
following figure. 
  

  
System setting windows of HMI system 

b. Password table setup  
After pressing button, open level will depend on user priority. 

After downloading to HMI, you can’t open this password table if your 
password level is lower than setting level. If you can open password 
table, you can change the password that level is lower than yours and 
you can’t change or see those password that is higher than yours.  

 
Password table 

Move left 

Move 
Increase 

Decrease 
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Password table for level 5 

 
c. Enter password  

This button provides password enter interface. It will open 
corresponding priority by inputting password. The higher level you 
input, the higher priority you have. 

 

 

Enter password window 
d. Contrast & Brightness  

This button provides HMI contrast and brightness adjustment. 
After pressing button, you will get following pop-up window for you to 
adjust as following figure. 

 

 
Contrast & Brightness setting window 

e. Low security  
This button will set user priority to the lowest (Level 0). You can 

use setting at exiting different screen to protect control system 

Enter and exit

Clear input 

Close 
Input 
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parameter not to be modified, mis-operation to cause system error. (it 
also provides this function when changing screen) 
 

f.  System menu 
After pressing button, HMI will back to system menu. User can 

back to operation screen by pressing “Exit” or re-startup. 
 

5. : uses to set the operation priority. Only the 
priority higher than setting can use it. 

Example: 

 

 
HMI System Menu 

3-3 Meter 

 
Meter options 

Meter 
type Icon Function 

Meter (1)  
Meter (2)  
Meter (3)  

It is used to distinguish if the meter of specific address 
exceeds high limit or less than low limit with different 
colors. The settings are max./min. value, high/low limit, the 
color of meter and scale and division number.   

Table 3-3-1 

Execute the user 

application program 

Select COM port 

for downloading 

Clear/Copy SMC 

card or internal 

memory 

Adjust LCM 

Adjust time 
Adjust 

System settings
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You can select your meter appearance with settings, such as the color 
and range of low limit, the color and range of high limit, the stitch color, division 
number, background color, etc. After setting, HMI will calculate the proportion 
automatically and fill your designated color into low limit, normal region and 
high limit. 
 

 
Fig. 3-3-1 Meter properties 

Select to get right 

window 

There are three styles for 

selection as following. 
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Fig. 3-3-2 Meter settings 

Properties:  
1. : Select address to execute meter function. 

 
Input address 

2. , ,
, : sets text, 

text size, font and text color by the setting that windows provides. 
  
3. , : to be 

rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  

Value unitValue 

format 

Max./Min. 

for 

Click to get left 

window 

Enable range 

limit setting 

Upper/lower bound 

Integer and 

fraction 

number of 

When target and high/low limit is

variable.  

Target address is read address + 3 

High limit address is read address +

2 
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4. , : user can 
select element style and foreground color as following figure. 

  

 

   
Standard               Raised                 Sunken 

Meter border Style 

5. , : sets the integral and fractional 

digits number.  
 
6. , : sets 

color for high/low limit region. 
  
7. : sets stitch color. 
  
8. , : sets 

scale color and scale number. 
  

9. , : sets value 

unit and format as following figure. 
  

   

10. , : set the 

max. / min. value for inputting. 

11. , ,

:Setting the target value for inputting 

12. , , : 

setting range limit. 
13. : setting target and high/low limit to variable or 

constant. 



 3-27

 
Target setting:1.constant (low limit=9999), 2. variable = the content of Dn+3 
(=D1003) 
low limit setting: 1. constant (low limit=0), 2. variable = the content of Dn+1 
(=D1001) 
high limit setting:1.constant (low limit=2500),2.variable = the content of 
Dn+2 (=D1002) 

Example: 

 

3-4 Bar  

 
Bar type Icon Function 
Normal 

bar  

Deviation 
bar  

To display the value of specific address by bar graph. 
You can know its quantity by the increment and 
decrement of square measure. It will use different color 
to mark if the value is less than low limit or higher than 
high limit. You can set max./min., the value and color of 
low/high limit, foreground/background color, etc.   

Table 3-4-1 
There are two types of bar graph: 
1. Normal bar: HMI will convert the value of PLC corresponding register to 

normal graph to show on HMI screen. 
  
2. Deviation bar: HMI will read the value of PLC corresponding register to 

compare to standard value. Then, convert deviation to deviation bar to show 
on HMI screen. 

  
3-4-1 Normal Bar 
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Fig. 3-4-1 Bar properties 

 

Change input text 

Click to get 

property window 

Low/high region 

There are four styles for

selection as following. There are four

display formats for

Value unit

Value 

Max./Min. 

value range Click to get left 

Enable range 

Input value limit 

Target and high/low limit is variable. 

Target address is read address + 3 

High limit address is read address + 

2 
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Fig. 3-4-2 Normal bar settings 
Properties: 
1. : Select address for bar. 

 

Input address 
2. , ,

, : to set 
text, text size, font and text color by the setting that windows provides. 

  
3. , : user can 

select element style and foreground color as following figure. 
  

 

                        
Standard           Raised           Sunken 

Bar style 
4. : sets bar display direction (right, left, top 

and bottom) as following figure.  
 

 
Bar display direction 

 
5. , : high/low 
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region color setting. 

6. , : setting 

data unit and format as following figure. 
  

  
 

7. , : setting 

max./min. value. 

8. , ,

:Setting the target value for inputting 

9. , , : 

setting range limit. 
  
10. : setting target and high/low limit to variable or 

constant. 
Target setting: 1. constant (low limit=9999), 2. variable = the content of Dn+3 
(=D1003) 
low limit setting: 1. constant (low limit=0), 2. variable = the content of Dn+1 
(=D1001) 
high limit setting: 1. constant (low limit=2500), 2. variable = the content of 
Dn+2 (=D1002) 

 
3-4-2 Deviation Bar  
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Fig. 3-4-3 Deviation properties 

 
Fig. 3-4-4 Deviation bar settings 

Change input text 

Click to get 

deviation bar 

There are four styles for 

selection as following. 

There are two 

display formats for 

deviation bar. 

Value unit

Value format 

Max. /Min. range

for inputting

Click to left 

Display deviation 

When standard value and high limit of

deviation value is variable.  

The address of standard value is read address

+1  
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Properties: 
1. : Select address for deviation bar. 

 

Input address 
 

2. , ,
, : setting 

text, text size, font and text color by the setting that windows provides. 
  
3. , : user can 

select element style and foreground color as following figure. 
  

 

                       

Standard           Raised           Sunken 
Deviation bar style 

4. : Display bar action direction 
(Horizontal/vertical) as following figure.  

 
display format 
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5. , : setting 

value unit and format as following figure.  

  
 

6. , : setting 

display range of bar graph. 
  

7. , ,

, ,

: setting target and high limit of deviation value. 

1. constant (following example=0), 2. variable = compare the content of Dn 
(=D1000) and standard value Dn+1(D1001). When difference is higher than 
deviation high limit Dn+2(D1002), it will use different color to display. 

 
Example: 

 
Read: D1000, use bar graph to display the value of PLC 
corresponding register=Dn 
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3-5 Pie Graph 

 
Button 
type 

Icon Function 

Pie (1)  
Pie (2)  
Pie (3)  
Pie (4)  

To display the value of specific address by pie graph. You can 
know its quantity by the increment and decrement of area 
measure. It will use different color to mark if the value is less 
than lower bound or higher than upper bound. You can set 
max./min., the value and color of low/high  region, 
foreground/background color, etc.  

There are four types for selection and you can use the settings, includes 
color setting, max., min., high limit, low limit, etc. to design. The value will be 
changed by the reading address. 
  

 
Fig. 3-5-1 Pie graph properties 

Change input 

Click element to 

get properties 

There are four styles for 

selection as following. 
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Fig. 3-5-2 Pie graph settings 

Properties 
1. : the address for pie graph as following 

picture. 

 
Input address 

Value unit

Value format

Max./Min. 

value for

Click to get left 

Enable range 

Limit for inputting When target and high/low limit is 

variable.  

Target address is read address + 3 

High limit address is read address + 

2 
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2. , ,

, : to set 
text, text size, font and text color by the setting that windows provides. 

 
3. , : user can 

select element style and foreground color as following figure. 
  
4. , : High/low 

region color setting. 
  

5. , : sets data 

unit and format as following figure. 
  

  

6. , : sets 

max./min. value. 
  

7. , , : sets 

range limit. 
 
8. : setting target and high/low limit to variable or 

constant. 
Target setting: 1. constant (low limit=9999), 2. variable = the content of Dn+3 
(=D1001) 
low limit setting: 1. constant (low limit=0), 2. variable = the content of Dn+2 
(=D1002) 
high limit setting: 1. constant (low limit=2500), 2. variable = the content of 
Dn+1 (=D1003) 

 
Example: 
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3-6 Indicator 

 
Indicator 
type 

Icon Function 

Multistate 
indicator  

To display the state of PLC corresponding contact (ON or OFF) 
or register  

Range 
indicator  

To display the state of comparison result (compare PLC 
corresponding contact (ON or OFF) or register with low limit of 
range)  

There are two indicators for selection: 
1. Multistate indicator: provides a method to display PLC corresponding 

contact (ON or OFF) or register. State number will be different by unit setting. 
(Value: 256 states, LSB: 16 states, BIT: 2 states) The content of indicator 
could be text or figure. 

 
2. Range indicator: compare PLC corresponding contact (ON or OFF) or 

register with low limit of range. Then, display the corresponding state of 
comparison result on HMI screen.  

 
3-6-1 State Indicator 
 

State indicator provides a method to indicate specific address. It will send 
state changes message to user no matter it is Bit, LSB or WORD. If this address 
is an important pointer or important message or important alarm, state indicator, 
it can be used to inform user immediately by changing display state method or 
different text setting. Or even changes by different states to let user get more 
information and user can also handle the corresponding state immediately.  
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Fig. 3-6-1 Indicator properties 
Properties: 
1. : Setting the address to execute state 

indicator as follows. 

 
Input address 

States: ▲next 

state or ▼ 

State is 0 and input 

text will be shown 

Change input text 

Value unit

Select to get right 

properties table. Change state 

Value format 
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2. , ,
, : sets text, 

text size, font and text color by the setting that windows provides. 
  
3. , : to be 

rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  
4. : user can select element foreground color 

as following figure. 
  

5. , : sets value 

format and unit as following figure. 
  

  
Example: 

 
 
3-6-2 Range Indicators 
 

Compares PLC corresponding contact (ON or OFF) or register with low 
limit of range. Then, display the corresponding state of comparison result on 
HMI screen.  
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Fig. 3-6-2 Range indicator properties 

  
Fig. 3-6-3 Range indicator settings 

States: ▲next 

state or ▼ 

State is 0 and input 

text will be shown 
Change input text 

Value unit

Select to get right 

properties window Change state number

Value format

Click to get left window

Enable range 

limit setting 
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Properties: 
1. : Select address to execute range indicator 

as following figure.  

 
Input address 
2. , ,

, : sets text, 
text size, font and text color by the setting that windows provides. 

  
3. , : to be 

rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  
4. : user can select element foreground color 

as following figure. 
  

5. , : value 

format and unit settings as following figure.  

  
 
6. : State number will be different by unit 

setting. (Value: 256 states, LSB: 16 states, BIT: 2 states) 
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7. , , , : The low 

limit of each state range settings. It can be 1: constant or 2: variety (low limit 
of each state range is Dn+1,2,3…(state number-1)  

 
Example: 
Consider that state number of range indicator is 5 and the value range =4 

                           
Range (constant) 0=400         1=300           2=200          3=1000 
Range (variable) Dn+1            Dn+2           Dn+3           Dn+4 

3-7 Data Display  

 

Button type Icon Function 
Numeric display  Display value of specific address 
Character display  Display character of specific address 
Date display  Display HMI date  
Time display  Display HMI time 
Day-of-week 
display 

 Display HMI day-of-week 

Prestored message  Display message by state 
Moving sign  Display message by state with moving sign 

 
3-7-1 Numeric Display 
 

To display the value of PLC corresponding register with numeric on HMI 
screen directly. 
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Fig. 3-7-1 Numeric display properties 

 
3-7-2 Character Display 
 

HMI reads the ASCII of PLC corresponding register and convert them to 
character to display on screen. (The max. length is 28 words) 

Integer and fraction 

number setting 

Date type 

Display read address

There are four styles 

for selection. 
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Fig. 3-7-2 Character display properties 

 
3-7-3 Date Display 
 
To display HMI system date. It provides display format for selection.  

Read address
Display read 

String length 

There are four styles 

for selection. 
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Fig. 3-7-3 Date display settings 

3-7-4 Time Display 
 
Displays HMI system time. It provides display formats for selection.  

Date display format

There are four styles 

for selection. 
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Fig. 3-7-4 Time display setting 

 
3-7-5 Day-of-week Display 
 
It provides to display HMI system date. 

Time display format 
There are four styles 

for selection. 
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Fig. 3-7-5 Day-of-week display settings 

 
3-7-6 Prestore Message 
 

Display the state content of PLC corresponding contact or register 
directly. You can set state number and text for each state. 

Switches each day-of –week 

and change display text by 

clicking state.

There are four styles

for selection. 
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Fig. 3-7-6 Prestore message settings 

3-7-7 Moving Sign Display 

Display the state content of PLC corresponding contact or register by 
moving sign. You can set the movement point and interval time. 

Read address

State number 

Display read address 

Setting display text

There are four 

styles for 
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Fig. 3-7-7 Moving sign settings 

3-8 Graph Display  

 
Button type Icon Function 

State graphic  

When HMI connects to PLC, it is used to display 
many pictures controlled by PLC on HMI screen. PLC 
also control its state to display different pictures by 
state.  

Animated 
graphic  

When HMI connects to PLC, it is used to display a 
picture controlled by PLC on HMI screen. PLC can 
also control its X and Y direction to move by yourself 
and display different pictures.  

 
3-8-1 State Graphic 
 

When HMI connects to PLC, it is used to display many pictures controlled 
by PLC on HMI screen. PLC also control its state to display different pictures by 
state.  

Read address 

Display address data

Chang output text

State number 

Moving points 

and interval 

There are four styles 

for selection. 
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Fig. 3-8-1 State graphic 

 
Properties: 
1. : Select address for executing state graphic.  

 
Input address 

Read address

Change picture 

Read address data

State number 

Change rate 
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2. , : to be 
rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 
  

3. , : setting 

value unit and format as following figure. 
  

  
 
4. : state number of state graphic. There are 

1-256 states for unit WORD, 16 states for LSB and 2 states for Bit. 
  

5. , : 
changes rate of each state setting. 
 

Example:  
Consider that designated read address = D100.  
The memory content and each state should be as follows. 

                                
D100=1    D100=2    D100=3    D100=4    D100=5   D100=6  D100=7 
 
3-8-2 Animated Graphic 
 

When HMI connects to PLC, it is used to display a picture controlled by 
PLC on HMI screen. PLC can also control its X and Y direction to move by 
yourself and display different pictures. 
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Fig. 3-8-2 Animate graphic settings 

Properties: 
1. : the address to execute animate graphic as 

following figure.  

 
Input address 

Read address

Read address 

State number
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2. , : to be 
rich screen with the pictures from picture bank. Refer to chapter 2 for detail. 

  

3. , : sets the 

value unit and format.  

  
 
4. : To clear previous picture when changing 

state. 
  
5. : state number of state graphic. There are 

1-256 states for unit WORD, 16 states for LSB and 2 states for Bit. 
  
Example: 
Consider that designated address =D100,  
each state and memory content should be as follows.  
State control register Dn+1 

     X-axis control register Dn+2 

 
Y-axis control register Dn+3 

 

3-9 Input 

 

Button type Icon Function 
Numeric 
Entry  

To display the numeric of PLC corresponding 
contact (ON or OFF) or register  

Character 
Entry  

To display the character of PLC corresponding 
contact (ON or OFF) or register  

It provides you to input read/write address to display/input value. 
Read/write address can be the same or different. 
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3-9-1Numeric Entry 

 
Fig. 3-9-1Numeric entry properties 

 
Fig. 3-9-2 Numeric entry settings 

Value unit 

Value format 

Click to get left 

window  

Max. /Min. Setting 

Integral and 

fractional digits 

Trigger type setting 

Read address 

There are three 

styles for 

selection as 
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Properties: 
1. , : the 

address used to execute numeric entry.  

 
Input address 
2. , ,

, : sets text, 
text size, font and text color by the setting that windows provides. 

  
3. , : user can 

select element style and foreground color as following figure.  

 

              
Standard         Raised           Sunken 
Numeric entry style 
 
4. , : User 

can use this setting to trigger PLC after or before writing. Note: this function 
can only trigger PLC to be ON. If it needs to trigger again, you should set the 
address to be OFF by yourself. 
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5. : sets the user priority. Only the priority is 
higher than setting can use it. 

  

6. , : sets the 

value unit and format. 
  

7. , : Min./Max. 

value setting. 
  

8. , : integral and fractional digitals 

number setting. 
  
Example: 

After pressing button, you will get pop-up box as follows to input value to 
PLC corresponding register D1000. 
 

 

 
 
3-9-2 Character Entry 
 

HMI reads the ASCII of PLC corresponding register and convert them to 
character to display on screen. (The max. length is 28 words) 

You can input value 

You will get following 

dialog box after 
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Fig. 3-9-3 Character entry properties 

Properties: 
1. , : the 

address for character entry.  

 
Input address 

Character length

There are three 

styles for selection.
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2. , ,
, : sets text, 

text size, font and text color by the setting that windows provides. 
  
3. , : user can 

select element style and foreground color as following figure. 
  

 

      

Standard                Raised                 Sunken 
Character Entry style 
 
4. : sets the user priority. Only the priority is 

higher than setting can use it. 
  
Example: 

After pressing button, you will get ASCII-KEY on HMI screen. You can 
input ASCII code of character. (D1000~Dn, n: character length) 

  

 

 

 
ASCII-KEY dialog box 
 

After pressing 

character entry 

button, you will get 

following dialog box. 
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3-10 Curve 

 

Curve 
type 

Icon Function 

Trend 
graph  

To display the value change of setting address by trend 
graph. The trend graph can only display the change of Y-axis.

X-Y Chart  

To display the value change of setting address by trend 
graph. The trend graph can display the change of X-axis and 
Y-axis. 

The first step for setting curve is setting the curve number in “curve field 
total” (range is 1-4). Then, setting read address, curve width, color and value 
style to finish setting. 
 
3-10-1 Trend Graph 
 

HMI will convert a series value of PLC corresponding register to trend 
graph on screen. For example, consider that there are 100 sampling points and 
four curves. There will be 100 X 4 = 400 points. Take Delta PLC for example, 
consider that read address is D0, it will read 400 word (D0~D399) after triggering. 
Setting Y-axis of curve 1 is D0~D99, Y-axis of curve 2 is D100~D199, Y-axis of 
curve 3 is D200~D299 and Y-axis of curve 4 is D300~D399. If there is value that 
exceeds maximum value, it will be displayed with maximum value. If there is 
value that less than minimum value, it will be displayed with minimum value. 
After setting, you should set control address to trigger read data of trend graph, 
trend graph drawing and clear curve. Refer to chapter 5 for control setting. 
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Fig. 3-10-1 Trend graph properties 

 
Fig. 3-10-2 Trend graph setting 

Curve field total

setting 

Click to get left 

dialog box 

There are three styles 

for selection.
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Trend graph properties: 
1. , ,

: user can select element border color, style 
and foreground color as following figure. 

 

     
Standard               Raised                 Sunken 

Trend graph style 
 

2. : Sets the reading sample number for trigger. 

After reading to get trend graph, it will stop sampling. 
 

3. : Selects value unit by PLC. 

  
4. : reads address setting. 

  

5. : Sets trigger and clear flag. When sample 

flag is triggered, it will start to read data and draw curve. 
  

6. : Sets curve detail settings (number is from 1 to 4) 
  

7. , : Max./Min. 

setting of Y-axis. If Max./Min. is higher/lower than the settings, it will use the 
setting to display. 
  

8. , : setting 

curve width (1-8) and curve color. 
  

Example: 
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3-10-2 X-Y Chart 
 

HMI will convert a series value of PLC corresponding register to X-Y chart 
on screen. For example, consider that there are 100 sampling points and four 
curves. There will be 100 X 4 X 2= 800 points. Take Delta PLC for example, 
consider that X-axis address is D0 and Y-axis address is D500, it will read 800 
words (D0~D399 and D500~D899) after triggering. Setting X-axis of curve 1 is 
D0~D99, Y-axis of curve 1 is D500~D599, X-axis of curve 2 is D100~D199 and 
Y-axis of curve 2 is D600~D699, X-axis of curve 3 is D200~D299 and Y-axis of 
curve 3 is D700~D799, X-axis of curve 4 is D300~D399 and Y-axis of curve 4 is 
D800~D899. If there is value that exceeds maximum value, it will be displayed 
with maximum value. If there is value that less than minimum value, it will be 
displayed with minimum value. After setting, you should set control address to 
trigger read data of curve graph, X-Y chart drawing and clear curve. Refer to 
chapter 5 for control setting.  
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Fig. 3-10-3 X-Y Chart properties 

 
Fig. 3-10-4 X-Y Chart settings 

Click to get left 

There are three 

styles for 

selection as 
Curve field total

setting 
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Properties: 
1. , ,

: user can select element border color, style 
and foreground color as following figure. 
  

 

     
Standard               Raised                 Sunken 

X-Y Chart style 

2. : Sets trigger and clear flag. When sample 

flag is triggered, it will start to read data and draw curve. 
  

3. : Selects value unit by PLC. 

  

4. , : sets the 

read address. 
  

5. : Sets trigger and clear flag. When sample 

flag is triggered, it will start to read data and draw curve. 
  
6. : Sets curve detail settings (number is from 1 to 4) 
  

7. , ,

, : Max./Min. 

setting of X-axis/Y-axis. If Max./Min. is higher/lower than the settings, it will 
use the setting to display. 
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8. , : setting 

curve width (1-8) and curve color. 
  
Example: 

 

3-11 Sampling 

 
 
Displays history data by table or graph for user to read easily. Therefore, 

the properties setting can be set when there is history buffer setting. After 
setting, you need to set control address to trigger to read history data and draw 
graph. Refer to chapter 5 for control setting. 
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Fig. 3-11-1Hisotry setup 

 
Fig. 3-11-2 Buffer properties 

a. Read address: sets PLC corresponding address for 
reading by buffer #1 to #12. For example, D1000 is the 
start address. 

  

b. Size (word) and total: value unit and sample times. When 
you set 8 for Size (word), it means that 8 words = D1000, 
D1001, D1002, D1003,…., D1007. Total is the max. sample 
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times.  

 

c. Stamp time and data: to record time and data when 
sampling. 

  

d. Auto stop: to stop sampling when sample times exceeds 
total or not. For example, if  total is 5000 now and you set 
not to auto stop. If it is 5001 times, the 5001 data will be 
saved in the first data. The first data will be overwritten.  

 

e. Trigger: to select trigger by HMI or PLC. When you set to 
trigger by PLC, refer to chapter 5 for setting. 

 

f . Cycle: it is the sample cycle for triggering and the unit for 
cycle is second. 

 
g. Non-volatile: sets to save data in history buffer after power is off.  

 
3-11-1 Historical Trend Graph 
 

Converts history data to trend graph to display on HMI screen with series 
curves.  
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Fig. 3-11-3 Historical trend graph properties 

 
Fig. 3-11-4 Historical trend graph settings 

Properties: 

Curve number 

Click to get left window 
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1. , : sets 
border color and foreground color. 

  

2. : sets PLC corresponding address for 

reading by buffer #1 to #12. User can enter to set by clicking button 

 or from menu bar Options > History setup. 

 

3. : Selects value unit by PLC. 

 

4. , : Max./Min. 

setting of X-axis/Y-axis. If Max./Min. is higher/lower than the settings, it will 
use the setting to display. 

 
  

5. , ,

: sets time/date format when displaying 

simultaneously. 
 
6. : Sets curve detail settings (number is from 1 to 4) 
 

7. : Sets the reading sample number for trigger. 

After reading to get trend graph, it will stop sampling. 
  

8. , : sets 

curve width (1 to 8) and color.  
 
Example: 
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3-11-2 Historical Data Table 
 

Converts history data to data table to display on HMI screen. The buffer 
number will correspond to data no.  

 
Fig. 3-11-5 Historical data table properties 

 
Properties: 
1. , : sets 

Click to get left Data field 

Select buffer 
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border color and foreground color. 
  

2. : sets PLC corresponding address for 

reading by buffer #1 to #12. User can enter to set by clicking button 

 or from menu bar Options > History setup. 

 

3. : Selects value unit by PLC. 

 

4. , : Max./Min. 

setting of X-axis/Y-axis. If Max./Min. is higher/lower than the settings, it will 
use the setting to display. 

  

5. , ,

:  sets time/date format when displaying 

simultaneously. 
  
6. : Sets curve detail settings (number is from 1 to 4) 
  

7. : Sets the reading sample number for trigger. 

After reading to get trend graph, it will stop sampling. 
 

8. , : sets integral digits and fractional 

number. 
 
Example: 
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3-11-3 Historical Event Table 
 

Converts data of PLC corresponding register to character to display on 
screen with event table. You can set display message, color and HMI will display 
message on screen after reading data. 
 

 

State number

Data No. : buffer number 

(1-12).  The historical 

buffer address for 

saving historical 

message. The address 

and size of buffer 

should be defined first.  

 

Data type: when it is WORD,

max. is 256 messages for a

WORD.  

When it is LSB, max. is 16 
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Fig. 3-11-6 Historical event table properties 
 
Properties: 
1. , ,

, : sets text, 
text size, font and text color by the settings that windows provides. 

  
2. , : sets 

border color and foreground color. 
  

3. , : sets state 

number of historical event. There are 1-256 states for unit WORD, 16 states 
for LSB and 2 states for Bit. 

  

4. : Sets the reading sample number for trigger. 

After reading to get trend graph, it will stop sampling. 
  
 

5. : sets PLC corresponding address for 

reading by buffer #1 to #12. User can enter to set by clicking button 

 or from menu bar Options > History setup. 

 

6. , ,

: sets time/date format when displaying 

simultaneously. 
 
Example:  
D1000=0   
D1000=1   
D1000=2   
D1000=3   
D1000=4   
D1000=5   
D1000=6   
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3-12 Alarm 

 
 
 
 
Alarm 
type 

Icon Function 

Alarm 
history 
table 

 

HMI will read relative bit data of designated PLC register in 
fixed time and convert the corresponding contact to alarm 
message to display on screen. It will record all alarm 
messages to be alarm history table.  

Active 
alarm list  

HMI only displays the current alarm setting of corresponding 
PLC data (unit is bit) on screen.  

Alarm 
frequency 

table 
 

HMI accumulates and displays alarm messages times on 
screen.  

 
Before setting alarm, you should set the PLC corresponding address, total 
numbers of alarm record and records’ size first.  
 
3-12-1 Alarm History Table 
 

HMI will read relative bit data of designated PLC register in fixed time and 
convert the corresponding contact to alarm message to display on screen. It 
will record all alarm messages to be alarm history table. 
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Fig. 3-12-1 Alarm History Table 

3-12-2 Active Alarm List 
 

HMI only displays the current alarm setting of corresponding contact of 
PLC bit data on screen. 
 



 3-76

 
Fig. 3-12-2 Active alarm list 

 
3-12-3 Alarm Frequency Table 
 

HMI accumulates and displays alarm messages times on screen. 
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Fig. 3-12-3 Alarm frequency table 

3-13 Graphics 

Maybe you need some graphics that are not provided; you can create 
your graph by combining from following basic graphics. 

  

 
Fig. 3-13-1 Graphics options 

3-13-1 Line 
 

Right-click and hold on to drag to the length you need and release to get 
the line. When selecting this line, you will get a rectangle range for you to move 
and adjust. You can set Line color and size in property table. 
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Fig. 3-13-2 Line properties 

 
 

Fig. 3-13-3 Line direction 
 

Fig. 3-13-4 Line width (1 to 8) 
 
3-13-2 Rectangle 
 

Right-click and hold on to drag the size you need and release to get the 
rectangle to import picture from picture bank. You can set its border size and 
foreground color.  
                                                                                        

 
Fig. 3-13-5 Rectangle properties 

Select picture from picture bank

Border size 
Transparent effective 

Foreground 

Line color 
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3-13-3 Circle 

 

Fig. 3-13-6 Circle properties 
Uses rectangle size to form a circle. If length = width, that will be a circle. 

Otherwise, that will be an ellipse. You can set color. The part that is out of circle 
and in the rectangle will be transparent.  

 
Fig. 3-13-7 When Transparent is “No”

 
Fig. 3-13-8 When Transparent is “No”

 
Fig. 3-13-9 When Transparent is “Yes”

 
Fig. 3-13-10 When Transparent is “Yes”

3-13-4 Polygon 
 

Left-click to set each point of polygon. After setting all points, you can 
right-click to get a polygon. You can set its size and change shape. The part that 
is out of polygon and in the rectangle will be transparent. Polygon also can be 
transparent by set “Yes” to transparent in polygon properties. Once there is 
something under polygon, it will be displayed due to transparent polygon.  

 

Fig. 3-13-11Polygon properties 
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Fig. 3-13-12 

 
Fig. 3-13-13 

 

Fig. 3-13-14 

 
Fig. 3-13-15 

 
Fig. 3-13-16 Transparent polygon 

 
3-13-5 Arc 
 

Right-click and hold on to drag to the size you need and release to get the 
arc. If transparent is “Yes” in property table, it will be arc or it will be a sector. 
The part that is out of arc and in the rectangle will be transparent. You can also 
change rectangle to change sector shape and arc size.  

 

Fig. 3-13-15 Arc property 

 
Fig. 3-13-16 When Transparent is “No”

 
Fig. 3-13-17 When Transparent is “Yes”

 
3-13-6 Text 
 

To plan a rectangle to input the text you need. You can fill rectangle with 
foreground color. (transparent should be “No”)  
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Fig. 3-13-18 Text property 

3-13-7 Scale 
 

To get a scale by setting scale direction, main scale number, subscale 
number, display scale or not, color, etc.   

 
Fig. 3-13-19 Scale properties 

Input text 
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Fig. 3-13-20 Scale properties 

 
3-13-8 Table 
 

You can change cells size, appearance and cells color. You can use table 
with other element to get completely table. 

Value unit

Value format 

Click to get left 

window  

Min. 

Max. value 

Integral/fractional 

digits number 
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Fig. 3-13-21 Table example 

Row header: Sets color for row header   

 
Column header: Sets color for column header 
 
Row interlacing: Sets color for row interlacing 
 
Column interlacing: Sets color for column interlacing 
 
Row header interlacing: Sets color for row header interlacing 
 
Column header interlacing: Sets color for column header interlacing 
 
Sep. row evently: Make multiple rows the same size. 
 
Sep. column evently: Make multiple columns the same size. 
 



 4-1

Chapter 4 Macro 
It is convenient for HMI users to operate with Macro. After editing Macro, user 

can test the Macro correction by on-line simulation or off-line simulation before 
downloading to HMI. The lines number for each macro is 512 lines and 128 words 
(max.) for writing comments or strings in a line. The sub-macro number is 512 
sub-macros (number is 1-512). See figure 4-1 and figure 4-2.  

 

 

Figure 4-1 
You can comment each macro by 
sub-macro function for convenient 
management, maintain and operation. The 
initial name of all sub-macro is Sub-macro
(n) (n is from 1 to 512).  

 

Figure 4-2 
The left-most field in the left window is 
sub-macro number. There are 512 
sub-macros for edition. You can write 
“CALL n (n is from 1 to 512)” to use 
sub-macro. 
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4-1 Macro Type 

 
Fig. 4-1-1 Choosing Macro from menu bar 

Macro name Number Explanation 
Screen open 

Macro 
1 There is a screen open macro for each screen. Therefore, 

there are n screen open macros for n screen.  
Screen close 

Macro 
1 There is a screen close macro for each screen. Therefore, 

there are n screen close macros for n screen. 
Screen Cycle 

Macro 
1 There is a screen cycle macro for each screen. Therefore, 

there are n screen cycle macros for n screen 
Initial Macro 1 There is only an initial Macro in a program.  
Background 

Macro 
1 There is only an initial Macro in a program.  

Clock Macro 1 There is only an initial Macro in a program. 
On Macro 1 You can have an ON Macro for each specific button. 
Off Macro 1 You can have an OFF Macro for each specific button. 
Sub-macro 512 There are only 512 sub-macros for a program.  

Table 4-1-1 

� Screen Open Macro  
You can have a screen open Macro for each screen. Screen open Macro will only 
be executed ONCE when you open screen (or change to that screen) and finish 
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execution ONCE. The screen element will be displayed after finishing executing 
screen open screen. Therefore, you should be careful to design for screen open 
Macro to avoid dead loop (program can’t be ended) to cause system delay or 
even can’t execute screen’s elements. It is not recommended to write too long 
macro unless necessary. Please pay attention for loop usage and test Macro 
with on-line/off-line simulation before downloading to HMI. 

 

� Screen Close Macro  
You can have a screen close Macro for each screen. Screen close Macro will 
only be executed ONCE when you close screen and finish execution ONCE. The 
screen open macro of new screen will be only executed after finishing screen 
close Macro. Therefore, you should also be careful for dead loop (program can’t 
be ended) to avoid unexpected error.  

 

� Screen Cycle Macro  
You can have a screen cycle Macro for each screen. Screen cycle Macro will only 
be executed ONCE when you change screen and the macro will be executed 
continuously until changing screen, program or stopping machine. Therefore, It 
is not recommended to write too long macro unless necessary.  

 

� Initial Macro 
There is only an initial Macro in a program or a machine. It is executed in the 
beginning of program. You can preset value to omit step-by-step settings and 
also control initial setting to avoid unexpected problem by unknown initial value. 
If you need to have any special setting in PLC special address, you can use 
initial macro to set it. It can save much time with well-designed initial macro.  
 

� Background Macro 
There is only an initial Macro in a program or a machine. It will be executed 
continuously like background. But it is only executed some commands ONCE, 
not finish executing ONCE. If there is other executed Macro, such as cycle 
macro, it won’t have any influences. They will be executed almost at the same 
time (In fact, it is executed one by one. The execution time is very close and 
almost at the same time). You don’t need to write loop for continuous execution. 
And even you write END command for Macro, it will still execute Macro again.  
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� Clock Macro 
There is only an initial Macro in a program or a machine. It will be executed 
continuously, finish execution ONCE and executed again like cycle macro. 
Therefore, It is not recommended to write too long macro unless necessary. 

  

� ON Macro 
You can have an ON Macro for each specific button (bit). It is set to be ON to start 
Macro by this button setting. So it is called ON Macro. This Macro is also 
executed ONCE and finished executing ONCE. It will be started again when this 
button is set to be ON again. The ON Macro will be only started when the button 
is set to be ON and pressed button to be ON. 

 

� OFF Macro 
You can have an OFF Macro for each specific button (bit). It is set to be OFF to 
start Macro by this button setting. So it is called OFF Macro. This Macro is also 
executed ONCE and finished executing ONCE. It will be started again when this 
button is set to be OFF again. The OFF Macro will be only started when the 
button is set to be OFF and pressed button to be OFF. 

 

� Sub-macro 
There are 512 sub-macros for editing. The sub-macro likes subroutine in 
program. User can write repeated action/function in sub-macro to save macro 
editing time and easy maintain. For example, if there are 10 sub-macros use one 
specific function, you can write it to be a sub-macro. Considers that the function 
is written to be sub-macro 1, you only need to write “CALL 1” in Macro to use it. 
Even if you need to modify this sub-macro, you only need to modify this 
sub-macro without modifying 10 macros. The sub-macro can be named by its 
function for easy management. 

 

4-2 Macro Edition 

After choosing desired Macro from menu bar, you can start editing by clicking 
any line as Fig. 4-2-1. The Macro window will be different by clicking position and the 
left number is line number.  
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Fig. 4-2-1 Start editing Macro 

There are 512 lines (number is from 1 to 512) for editing Macro. (refer to Fig. 4-2-3) If 
there is any blank line in the program, the blank lines will be set to comment lines 
after updating as Fig. 4-2-4.  
  

 

Fig. 4-2-2 Toolbar 
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Fig. 4-2-3 The last line of Macro 

 
Fig. 4-2-4 Blank line will be comment line 

When you start editing Macro, you can get edition window as Fig. 4-2-5 by clicking 
any lines in the Macro. You can edit with command window by clicking command 
from menu bar. Refer following for edition method. 
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Fig. 4-2-5 Macro edition window 

� File 

 
Fig. 4-2-6 File 

� Open Macro  
We provide open old macro for convenient edition macro. User can open old 
Macro when using any brand PLC to save Macro edition time without re-input. 
Refer to Fig. 4-2-7 for open Macro. 
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Fig. 4-2-7 Open Macro 

� Save Macro  
In the same way, we also provide “save as” function for user to modify old 
macro and save macro as other macro to backup or save time to input. 
 

 
Fig. 4-2-8 “Save as” Macro 

� Close Macro  
You can close macro by clicking this item or pressing ESC key. 
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� Edition 
You can edit with edition options. If it is PLC address, it will be in bracket to 
distinguish with internal memory. 
 

 
Fig. 4-2-9 Edition 

� Previous 
 

Moving selected line to the upper line and upper line will move backward a line 
as Fig. 4-2-10 and Fig. 4-2-11.  

 
Fig. 4-2-10 Step 1 of moving forward 
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Fig. 4-2-11 Step 2 of moving forward 

� Next 
 

Moving selected line to the lower line and lower line will move forward a line as 
Fig. 4-2-12 and Fig. 4-2-13.  

 
Fig. 4-2-12 Step 1 of moving backward 
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Fig. 4-2-13 Step 2 of moving backward 

� Update 
 

Updates current line of macro. If you didn’t press “update” after edition, it won’t 
be modified. That is used to give the user a chance to modify or not. Therefore, if 
you forget to update after edition, you should input again. Refer to Fig. 4-2-14 
and Fig. 4-2-15 for detail.  
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Fig. 4-2-14 Step 1 of update 

 
Fig. 4-2-15 Step 2 of update 

� Insert 
 

Inserts a line before selected line. Refer to Fig. 4-2-16 and Fig. 4-2-17. 
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Fig. 4-2-16 Step 1 of insert 

 
Fig. 4-2-17 Step 2 of insert 

� Delete 
 

Deletes selected line. If there are lines after this delete line, they will be moved 



 4-14

forward. Refer to Fig. 4-2-18 and Fig. 4-2-19. 
 

 
Fig. 4-2-18 Step 1 of delete 

 
Fig. 4-2-19 Step 2 of delete 

� Comment 
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You can give comments for any lines to read/modify macro easily. You can 
choose from menu bar or toolbar. Refer to Fig. 4-2-20 and Fig. 4-2-21. 

 
Fig. 4-2-20 Step 1 of comment 

 
Fig. 4-2-21 Step 2 of comment 

� Command 
You can write command by clicking button “Command” or choosing from menu 
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bar. 
 

 
Fig. 4-2-22 Choosing from menu bar 

 

Fig. 4-2-23 Commands options 

 

Fig. 4-2-24 Arithmetic 

 

Fig. 4-2-25 Logical 
 

Fig. 4-2-26 Data move 
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Fig. 4-2-27 Data transfer 

 

Fig. 4-2-28 Comparison 

 

Fig. 4-2-29 Flow control 

 

Fig. 4-2-30 Bit setting 

 

Fig. 4-2-31 Communication 

 

Fig. 4-2-32 Others 

 

� Help 
It is on-line help as Fig. 4-2-33. 
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Fig. 4-2-33 Help options 

 
Fig. 4-2-34 On-line HELP 

� Key in  
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Some users are used to write Macro by key in. You can also key in by yourself 
and program will auto check the correction. You will get warning if there is any 
errors. Refer to following figures for detail. There are no limit spaces between 
operand and operation symbol for you to key in.  
 

 
Fig. 4-2-35 Operation 

 
After finishing inputting, program will convert to the best format automatically 
after updating or pressing Enter. But program didn’t verify in this time. 
 

 
Fig. 4-2-36 Convert to the best format 

You will get error syntax dialog box once you update. 
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Fig. 4-2-37 Incorrect syntax 

 
Fig. 4-2-38 Key in by yourself 

If your format is correct with error operand, you will only get error message 
when compiling. 
 

 
Fig. 4-2-39 Format is correct but operand is error 
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Fig. 4-2-40 there is error when compiling 

4-3  Macro Operation 
� Arithmetic 

Operation: there are five operations, ADD, SUB, MUL, DIV and MOD as Fig. 4-3-1. 
There are three operands for each operation. Each operand can be internal 
memory or constant (decimal or hexadecimal system) (but it can only be internal 
memory when outputting). The unit can be Word, Double Word, Signed and 
Signed Double Word. Refer to following table for detail. 

 

Command Operand Data type Format Others 
ADD A1, A2, A3 M, C W, D, S 
SUB A1, A2, A3 M, C W, D, S 
MUL A1, A2, A3 M, C W, D, S 
DIV A1, A2, A3 M, C W, D, S 

MOD A1, A2, A3 M, C W, D, S 

When the data exceeds the length 
of designated unit, the data out of 
range will be discarded. 

M— Internal memory, C—Constant, W—Word, D—Double Word, S—Signed 

 
Fig. 4-3-1 Choosing Arithmetic 

� ADD 
ADD → Add operation, formula: A1=A2+A3. Adds A2 to A3 and save the result 
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in A1. 
Example: 
A1(Word)=A2(Word) + A3(Word). 
A1(Double Word)=A2(Double Word) + A3(Double Word). 
A1(Signed)=A2(Signed) + A3(Signed). 
A1(Signed Double Word)=A2(Signed Double Word) + A3(Signed Double Word). 

 
Fig. 4-3-2 Addition 

� SUB 
SUB → subtraction, formula: A1=A2-A3. Subtracts A2 from A3 and you will get 
the result in A1. 
Example: 
A1(Word)=A2(Word) - A3(Word). 
A1(Double Word)=A2(Double Word) - A3(Double Word). 
A1(Signed)=A2(Signed) - A3(Signed). 
A1(Signed Double Word)=A2(Signed Double Word) - A3(Signed Double Word). 

 
Fig. 4-3-3 Subtraction 
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� MUL 
MUL → multiply, formula: A1=A2 * A3. 
Example: 
A1(Word)=A2(Word) * A3(Word). 
A1(Double Word)=A2(Double Word) * A3(Double Word). 
A1(Signed)=A2(Signed) * A3(Signed). 
A1(Signed Double Word)=A2(Signed Double Word) * A3(Signed Double Word). 

 
Fig. 4-3-4 Multiply 

� DIV 
DIV → division, formula: A1=A2 / A3. A1 is quotient and A3 can’t be 0. 
Example: 
A1(Word)=A2(Word) / A3(Word). 
A1(Double Word)=A2(Double Word) / A3(Double Word). 
A1(Signed)=A2(Signed) / A3(Signed). 
A1(Signed Double Word)=A2(Signed Double Word) / A3(Signed Double Word). 

 
Fig. 4-3-5 Division 
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� MOD 
MOD → get the remainder, formula: A1=A2 % A3. A1 is remainder and A3 can’t 
be 0. 
Example: 
A1(Word)=A2(Word) % A3(Word). 
A1(Double Word)=A2(Double Word) % A3(Double Word). 
A1(Signed)=A2(Signed) % A3(Signed). 
A1(Signed Double Word)=A2(Signed Double Word) % A3(Signed Double Word). 

 
Fig. 4-3-6 Get remainder 

 

� Logical Operation  
 

There are five operations for logical, including OR, AND, XOR, SHL and SHR as 
Fig. 4-3-7. There are three operands for each operation. Each operand can be 
internal memory or constant (decimal or hexadecimal system) (but it only can be 
internal memory when outputting). The unit can be Word and Double Word. 
Refer to following table for detail. 

 

Command Operand Data type Format Others 
OR A1, A2, A3 M, C W, D -- 

AND A1, A2, A3 M, C W, D -- 
XOR A1, A2, A3 M, C W, D -- 
SHL A1, A2, A3 M, C W, D -- 
SHR A1, A2, A3 M, C W, D -- 

M— Internal memory, C—Constant, W—Word, D—Double Word. 
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Fig. 4-3-7 Logical operation 

� OR 
OR → logical OR, formula is A1=A2 | A3. 
If A2(Word) and A3(Word) perform logical OR and save the result in A1(Word). 
(unit: bit) 
If A2(DWord) and A3(DWord) perform logical OR and save the result in 
A1(DWord). (unit: bit) 
 

Fig. 4-3-8 OR 

 
Fig. 4-3-9 Boolean operation 

� AND 
AND → logical AND, formula: A1=A2 & A3. 
If A2(Word) and A3(Word) perform logical AND and save the result in A1(Word). 
(unit: bit) 
If A2(DWord) and A3(DWord) perform logical AND and save the result in 
A1(DWord). (unit: bit) 
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Fig. 4-3-10 AND 

 
Fig. 4-3-11Boolean operation 

  

� XOR 
XOR → logical XOR, formula: A1=A2 ^ A3. 
If A2(Word) and A3(Word) perform logical XOR and save the result in A1(Word). 
(unit: bit) 
If A2(DWord) and A3(DWord) perform logical XOR and save the result in 
A1(DWord). (unit: bit) 

Fig. 4-3-12 XOR 

 
Fig. 4-3-13 Boolean operation 

  
� SHL 
SHL → shift left. Formula: A1=A2 << A3. 
Shifts A2 (WORD/DWORD) data to left (bit number is A3). Once you shift a bit left. 
It will fill 0 to right-most bit at the same time. When A2 is WORD: If A3 is greater 
than 16, A1 will become 0. When A2 is DWORD: If A3 is greater than 32, A1 will 
become 0. 
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Fig. 4-3-14 SHL 

� SHR 
SHR → Shift right, formula: A1=A2 >> A3. 
Shifts A2 (WORD/DWORD) data to right (bit number is A3). Once you shift a bit 
right. It will fill 0 to left-most bit at the same time. Consider that A2 is WORD: If 
A3 is greater than 16, A1 will become 0. Consider that A2 is DWORD: If A3 is 
greater than 32, A1 will become 0. 
 

 
Fig. 4-3-15 SHR 

� Data move  
There are four commands for moving data, including MOV, BMOV, FILL and CHR 
as Fig. 4-3-16. Refer to following table for detail. (output only can be internal 
memory) 
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Command Operand Data type Format Others 
MOV A1, A2 P, M, C W, D Data type for A1 only can 

be P, M 
BMOV A1, A2, A3 P, M, C W Data type for A1 and A2 

only can be P, M 
FILL A1, A2, A3 M, C W  
CHR A1, A2, A3 M, C W A2 is input string 

P—PLC, M— Internal memory, C—Constant, W—Word, D—Double Word 

 
Fig. 4-3-16 Choosing Data move from command 

� MOV 
Move data from A2 to A1. It can be A1(Word)=A2(Word) or 
A1(DWord)=A2(DWord). There is no change with data in A2 after executing MOV 
command. No matter A1 is PLC address or HMI register, the data will be moved 
to the other device by communication. 
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Fig. 4-3-17 MOV 

� BMOV 
BMOV → Block move. BMOV (A1, A2, A3) means to move data (number is A3) of 
data from address A2 to address A1. Data format is word. There is no influence 
for register A2. If the block length is longer than internal memory or max number 
of PLC register, there will be error when compiling. 
 

 
Fig. 4-3-18 BMOV 

 

� FILL 
FILL → fill the memory. For example, FILL(A1, A2, A3) means fill address A1 
with data in register A2 and the data number is A3. There is no influence for 
register A2. If the block length is longer than internal memory or max number of 
PLC register, there will be error when compiling. 
 



 4-30

 
Fig. 4-3-19 FILL 

� CHR 
CHR → convert text to ASCII code. For example, CHR(A1， “A2”) means convert 
text in address A2 to ASCII and save in A1. The length is 128 words (max.). 

 
Fig. 4-3-20 CHR 

� Data conversion 
There are 11 types for data conversion, including BCD, BIN, W2D, B2W, W2B, 
SWAP, XCHG, MAX, MIN, A2H and H2A as Fig. 4-3-21. Refer to following table for 
detail. 
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Fig. 4-3-21 Choosing for data conversion 

Command Operand Data type Format Others 
BCD A1, A2 M W, D -- 
BIN A1, A2 M W, D -- 
W2D A1, A2 M W, S -- 
B2W A1, A2, A3 M, C W -- 
W2B A1, A2, A3 M, C W -- 

SWAP A1, A2, A3 M, C W -- 
XCHG A1, A2, A3 M, C W, D -- 
MAX A1, A2, A3 M, C W, D, S -- 
MIN A1, A2, A3 M, C W, D, S -- 
A2H A1, A2 M, C W -- 
H2A A1, A2 M, C W -- 

P—PLC, M— Internal memory, C—Constant, W—Word, D—Double Word, S—
Signed. 

� BCD 
BCD → Binary Coded Decimal. Convert BIN to BCD format. For example, A1 = 
BCD(A2). It converts A2(Integer, Word or DWord) to BCD (Binary Coded Decimal) 
and save result in A1(BCD, Word or DWord). The effective value of A2 should be 
integer between 0~9999 or the Dword between 0~99999999. 
 



 4-32

 
Fig. 4-3-22 BCD 

� BIN 
Binary Coded Decimal → BIN. Convert BCD to BIN format. For example, A1 = 
BIN(A2). It converts A2(BCD, Word or DWord) to BCD (Binary Coded Decimal) 
and save result in A1(BCD, Word or DWord). The effective value of A2 should be 
integer between 0~9999 or the dword between 0~99999999. 

 
Fig. 4-3-23 BIN 

� W2D 
W2D → convert WORD to DOUBLE WORD. For example, A1 = W2D(A2) means 
converting A2 (Integer, Word) to double word (Integer, DWord) and save the 
result in A1(Dword, signed or unsigned). The effective value of A2 is the integer 
(Word， unsigned) between 0~65535 or the integer (Word, signed) between 
-32768~32767. This function is used to extend data length of 16bit singed word 
to 32bit Dword. 
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Fig. 4-3-24 W2D 
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� B2W 
B2W → convert BYTE to WORD. For example, A1=B2W(A2, A3) means 
converting BYTE data (number is A3) from A2 to WORD and save the result in 
A1(Word). The high byte will be filled with 0. In other words, that each word of A2 
is two bytes. These two bytes will be converted to two words to save in A1. For 
example, $30=B2W ($785, $65534) and consider that the value of $65534 is 12. 
That means converting 12 bytes (6 words) to 12 words from $785 to save in $30. 

 
Fig. 4-3-25 B2W 

� W2B 
W2B → convert WORD to BYTE format. A1 = W2B(A2, A3) means converting 
WORD data (number is A3) from low-byte of A2 to BYTE format (discard 
high-byte of A2) and save the result in A1(Word). For example, $65=B2W (*985, 
$985), if the value of $985 is 12 that means read 12 WORDS from low-byte of *985 
and convert these 12 WORDS to 12 BYTES (6 WORDS) to save in $65. 

 
Fig. 4-3-26 W2B 
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� SWAP 
Swap BYTE data. SWAP(A1, A2, A3) means swapping high-byte and low-byte of 
A2 (WORD) (number is A3) and save the result in A1.  

 
Fig. 4-3-27 SWAP 

� XCHG 
Exchange data. XCHG(A1, A2, A3) means exchanging A2(Word) and A1(Word). 
Exchange data number is A3. After execution, A1 and A2 data will be changed. 

 
Fig. 4-3-28 XCHG 

� MAX 
Gets max. value. A1 = MAX(A2, A3) means getting the max. value from A2 and A3 
and save the max. value in A1. (format can be Word, Dword, Signed Binary, 
Unsigned Binary) 
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Fig. 4-3-29 MAX 

� MIN 
Gets min. value. A1 = MAX(A2, A3) means getting the min. value from A2 and A3 
and save the min. value in A1. (format can be Word, Dword, Signed Binary, 
Unsigned Binary) 

 
Fig. 4-3-30 MIN 

� A2H 
Converts 4 ASCII to a four digits integer of hexadecimal system. A1 =A2H(A2) 
means converting the ASCII of A2 (4 WORDS) to integer and save the result in A1. 
For example, A2 is @200 and the content are @200=0039H, @201=0033H, 
@202=0035H and @203=0038H. The result of A1 =A2H(A2) is to save @210 in A1 
and the content of @210 =9358H (format is WORD). 
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Fig. 4-3-31 A2H 

� H2A 
Converts four digits integer of hexadecimal system to 4 ASCII code. A1 =H2A(A2) 
means converting A2 (1 WORD with hexadecimal) to the ASCII (4 WORDS) and 
save the result in A1. For example, A2 is @100 and the content is @100=1234H, 
after calculation, A1 will be @110=0031H, @111=0032H and @112=0033H and 
@113=0034H (format is WORD).  

 
Fig. 4-3-32 H2A 

� Comparison 
There are ten comparison operands: IF ==, IF !=, IF >, IF >=, IF <, IF <=, IF AND == 
0, IF AND != 0, IF == ON and IF == OFF as Fig. 4-3-33. Refer to following table for 
detail. 
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Fig. 4-3-33 Choosing comparison 

 
Command Operand Data type Format Others 

IF == A1, A2, A3 M, C W, D, S
The available format for A3 is only 
C 

IF != A1, A2, A3 M, C W, D, S
The available format for A3 is only 
C 

IF > A1, A2, A3 M, C W, D, S
The available format for A3 is only 
C 

IF >= A1, A2, A3 M, C W, D, S
The available format for A3 is only 
C 

IF < A1, A2, A3 M, C W, D, S
The available format for A3 is only 
C 

IF <= A1, A2, A3 M, C W, D, S
The available format for A3 is only 
C 

IF AND == 0 A1, A2, A3 M, C W, D 
The available format for A3 is only 
C 

IF AND != 0 A1, A2, A3 M, C W, D 
The available format for A3 is only 
C 

IF == ON A1, A2 M, C B 
The available format for A1 is P and 
C and for A2 is C 

IF == OFF A1, A2 M, C B 
The available format for A1 is P and 
C and for A2 is C 

P—PLC, M—internal memory, C—constant, W—Word, D—Double Word, S—

Signed, B—Bit 

� IF = = 
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IF A1==A2 THEN GOTO LABEL A3. When A1 is equal to A2, it will go to LABEL 
A3. The format can be Signed DW. 

 
Fig. 4-3-34 IF== 

� IF ! = 
IF A1!=A2 THEN GOTO LABEL A3. When A1 is not equal to A2, it will go to 
LABEL A3. The format can be Signed DW. 

 
Fig. 4-3-5-3 IF!= 

� IF > 
IF A1>A2 THEN GOTO LABEL A3. When A1 is greater than A2, it will go to 
LABEL A3. The format can be Signed DW. 
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Fig. 4-3-36 IF> 

� IF > = 
IF A1>=A2 THEN GOTO LABEL A3. When A1 is greater than or equal to A2, it will 
go to LABEL A3. The format can be Signed DW. 

 
Fig. 4-3-37 IF>= 

� IF < 
IF A1<A2 THEN GOTO LABEL A3. When A1 is less than A2, it will go to LABEL 
A3. The format can be Signed DW. 
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Fig. 4-3-38 IF< 

� IF < = 
IF A1<=A2 THEN GOTO LABEL A3. When A1 is less than or equal to A2, it will go 
to LABEL A3. The format can be Signed DW. 

 
Fig. 4-3-39 IF<= 

� IF AND = = 0 
IF (A1&A2)== 0 THEN GOTO LABEL A3. If one of A1 is False, it will go to LABEL 
A3. The format can be DW. 
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Fig. 4-3-40 IFAND==0 

� IF AND ! = 0 
IF(A1&A2) != 0 THEN GOTO LABEL A3. When all of A1 and A2 are TRUE, it will 
go to LABEL A3. The format can be DW. 

 
Fig. 4-3-41 IF AND!=0 

� IF = = ON 
IF A1==ON THEN GOTO LABEL A2. If A1 is 1 (ON) and it will go to LABEL A2. 
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Fig. 4-3-40 IF==ON 

� IF = = OFF 
IF A1==OFF THEN GOTO LABEL A2. If A1 is 0 (OFF) and it will go to LABEL A2. 

 
Fig. 4-3-43 IF==OFF 

� Flow Control 
There are seven types for flow control: GOTO, LABEL, CALL, RET, FOR, NEXT 
and END as Fig. 4-3-6-1. Refer to following table for detail. 
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Fig. 4-3-44 Choosing for flow control 

Command Operand Data type Format Others 
GOTO A1 C -- -- 
LABEL A1 C -- -- 
CALL A1 C -- -- 
RET None -- -- -- 
FOR A1 M, C -- -- 
NEXT None -- -- -- 
END None -- -- -- 

M— internal memory, C— constant 

� GOTO 
Branches unconditionally to a specific line such as GOTO LABEL A1. GOTO 
command will jump to designated label like Label A1. The designated label 
should be in the program. 

 
Fig. 4-3-45 GOTO 

� LABEL 
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A label such as LABEL A1. Please notice that the label can’t be repeated in a 
Macro but a label can be repeated use in different Macros. 

 
Fig. 4-3-46 LABEL 

� CALL 
Calls sub-macro such as CALL A1. You can transfer control to sub-macro by 
CALL command. It is usually used to control design of specific function or 
transfer parameter table or complicated operation. It should have RET command 
at the end of sub-macro to return to the original program to execute the next 
program. The sub-macro number could be 001~512 and you can name it by 
yourself. You also can CALL another sub-macro in the sub-macro. But the levels 
for CALL sub-macro should be less than 6 levels to avoid unexpected error and 
memory limit. 

 
Fig. 4-3-47 CALL 

� RET 
Return to Macro. This command is only for sub-macro. The corresponding 
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command of RET is CALL. 

 
Fig. 4-3-48 RET 

� FOR…NEXT 
It is for loop. ”FOR” is the start of loop and ”NEXT” is the end of loop. It can be 
nest loop and the max. is 5 levels. The program can be FOR A1. . NEXT, the loop 
times are decided by A1 (A1 can be constant or variable). When A1=0, the loop 
won’t be executed and it will jump to the next line of NEXT to execute. When A1 
>0, loop will be continuous execution for A1 times. You can change A1 value by 
command, but it can’t change loop times. Note: If loop is executed too many 
times (A1 is too larger), that may be cause CPU malfunctions for the Macro that 
needed to finish execution ONCE. 

 
Fig. 4-3-49 FOR 

� FOR/NEXT 
Repeats a group of statement for specific times. Each “FOR” command should 
have a “NEXT” command. The max. level is 5 loops such as FOR $1…,  FOR 
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$2…, FOR $3…, FOR $4…, FOR $5…  NEXT, NEXT, NEXT, NEXT, NEXT. 

 
Fig. 4-3-50 NEXT 

� END 
Ends the macro. The program after command END won’t be executed and it will 
execute from first line in the next time. Note: END means finishing executing 
macro. 

 
Fig. 4-3-51 END 

� Bit Settings 
There are three settings for BIT settings: SETB, CLRB and INVB as Fig. 4-13. 
Refer to following table for detail. 
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Fig. 4-3-52 Choosing for bit setting 

Command Operand Data type Format Others 
SETB A1 P, M B -- 

CLRBL A1 P, M B -- 
INVB A1 P, M B -- 

M—internal memory, P—PLC, B—Bit. 

� SETB 
Sets specific bit to be ON. Example: SETB A1. 

 
Fig. 4-3-53 SETB 

� CLRB 
Sets specific bit to be OFF. Example: CLRB A1. 
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Fig. 4-3-54 CLRB 

� INVB 
Sets specific bit to be inverse. Example: INVB A1. 

 
Fig. 4-3-55 INVB 

� Communication 
There are six communications: INITCOM, ADDSUM, XORSUM, PUTCHARS, 
GETCHARS and SELECTCOM as Fig. 4-3-56. Refer to following table for detail. 
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Fig. 4-3-56 Choosing for communication 

Command Operand Data type Format Others 
INITCOM A1~ A2 M W -- 
ADDSUM A1~ A3 M W -- 
XORSUM A1~ A3 M W -- 

PUTCHARS A1~ A4 M W -- 
GETCHARS A1~ A4 M W -- 

SELECTCOM A1 C 0 or 1 0: COM1, 1: COM2 

M— internal memory 

� INITCOM 
Initials COM port to setting communication protocol. 

 
Fig. 4-3-57 INITCOM 
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Fig. 4-3-58 Variable2 settings in INITCOM (communication protocol) 

 

Fig. 4-3-59 COM port 
 

Fig. 4-3-60 Communication interface 

 

Fig. 4-3-61 Data bit 
 

Fig. 4-3-62 parity bit 

 

Fig. 4-3-63 Stop bit  
Fig. 4-3-64 Baud rate 

Flow Control: In communication, the transmission speed is faster than receiving 
speed due to new transmission technology (compress immediately, debug). We need 
to use flow control to ensure that receiving device can handle all incoming data. 
Therefore, we have following flow control methods to ensure data security and 
complete data transmitted between computer and HMI. 
1. No Flow Control: disable. 
2. CTS/RTS: Request To Send (RTS) and Clear To Send (CTS). It uses handshaking 

signal to control receiving and sending data.  
3. DSR/DTR: It is also hardware flow control. It uses cable to connect between 

computer and HMI.  
4. XON/XOFF: it is software flow control. It is only used for 2400bps modem. The 

control method is to generate control code by software and add it in the 
transmission data. 
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Fig. 4-3-65 Flow control 
� ADDSUM 
It uses addition to calculate checksum. A1=ADDSUM (A2, A3) means A2 is the 
start address for calculation; A3 is data length and save the result in A1. 

 
Fig. 4-3-66 ADDSUM 

� XORSUM 
It calculates checksum by using XOR. A1=XORSUM (A2, A3) means A2 is the 
start address of data; A3 is data length and save the result in A1. 

 
Fig. 4-3-67 XORSUM 

� PUTCHARS 
It outputs characters by COM port. A1= PUTCHARS (A2, A3, A4) means A2 is the 
start address of transmission data, A3 is data length, A4 is the allowance 
communication time (unit is ms) and the result will be saved in A1. 
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Fig. 4-3-68 PUTCHARS 

� GETCHARS 
It gets characters by COM port. A1= GETCHARS (A2, A3, A4) means A2 is the 
start address of transmission data, A3 is data length, A4 is the allowance 
communication time (unit is ms) and the result will be saved in A1. 

 
Fig. 4-3-69 GETCHARS 

 
Fig. 4-3-70 Example 1 of Delta PLC 

 
This example is the initial Delta PLC. After selecting Delta communication 
protocol, it sets communication as following. 
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Fig. 4-3-71 Example 2 of Delta PLC 

Example 2 in Fig. 4-3-71 is the communication macro for background macro. 
Line 1 to line 3: Let Y0 be ON and write into internal memory *10. Line 4 to line 6: 
let Y0 be OFF and write into internal memory *30. And output ON data in line 12 
and output OFF data in line 14. Therefore, you will see Y0 LED will be alternate 
ON/OFF. From this example, you can know that communication Macro let you 
have PLC control right when you have PLC communication data. Even if those 
PLCs or new PLCs that our DOP series doesn’t provide, you can control those 
PLCs by using communication Macro with communication protocol.  

� SELECTCOM 
It is used to switch COM port. When you set PLC to NULL in module parameter, 
you can use two COM ports (0:COM1, 1:COM2) (All communication commands 
will handle the COM port you use after switching. There is no support or 
interference among different macro switch.) 

 
� Others 

There are five functions: TIMETICK, GETLASTERROR, GETSYSTEMTIME, 
comment and delay as Fig. 4-3-9-1. Refer to following for detail. 
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Fig. 4-3-72 Choosing for Others 

Command Operand Data type Format Others 
TIMETICK A1 M W, D -- 

GETLASSERROR A1 M W -- 
Comment A2 S -- -- 

Delay A1 C W  -- 
GETSYSTEMTIME A1 M W  

GETHISTORY A1, A2 M, C, P W, D Data can be 
stored in PLC

M -- Internal Memory, C -- Constant, S -- String, P -- PLC 

� TIME TICK 
Gets system time (CPU time) to write into specific address. Every 1 added means 
100ms is added. 

 
Fig. 4-3-73 TIMETICK 
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� GETLASTERROR 
Gets last error value. If command is correct, the result of GETLASTERROR will 
be 0. Even if each Macro is executed simultaneously, the error message won’t 
interfere one another. Refer to chapter 4-4 for error code. 

 
Fig. 4-3-74 TIMETICK 

� Comment 
It helps Macro to be readable. You only need to put “#” in the beginning of line to 
be comment. 

 
Fig. 4-3-75 Comment 

� Delay 
Delays user setting time by system. It will have system delay due to system 
multiplexer. Therefore, setting time will be increase due to system busy. Time 
unit is ms. 
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Fig. 4-3-76 Delay 

� GETSYSTEMTIME 

It will be used to read system time and save into memory by the order of year, 
month, day, week, hour, minute and second. In following figure 4-3-77, $10 = 
GETSYSTEMTIME. The system time will be saved into memory in order: year -- 
$10, month -- $11, day -- $12, week -- $13, hour -- $14, minute -- $15 and second -- 
$16.  

 

Fig. 4-3-77 GETSYSTEMTIME 

� GETHISTORY 

It is used to read the data in history buffer. Please refer to following example for 
detail. For example, $0=GETHISTORY($2, $3, $5, 1#1@D0, $7), $0 is total number 
that is written successful and the unit is DWORD. It only can be internal memory. 
$2 is buffer number and the unit is WORD. It can be internal memory or constant. 
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The buffer number is from 1 to 12 so the constant only can be 1 to 12. $3 is start 
address for sampling and the unit is DWORD. It can be internal memory or 
constant. $5 is points for reading and the unit is DWORD. It can be internal 
memory or constant. 1#1@D0 is the address for storing data and the unit is 
WORD. It can be internal memory or PLC. $7 is data type for reading and the unit 
is WORD. It can be constant and the range is from 0 to 2. (0 is read data only. The 
length for each buffer is from 1 to 8 WORDs and unit is WORD. 1 is read time 
only, including year, month, day, hour, minute and second. There are 6 WORDS 
for them and 1 WORD for each one. 2 is read time and data and unit is WORD. )  

 

Fig. 4-3-78 GETHISTORY 
 

 
Fig. 4-3-78 GETHISTORY Settings 

4-4 Error Message 
When compiling, it will shows errors in output window for user to find out easily. 
Some errors will be found out easily in short program. But that will be difficulty for 
long Macro. To help user to debug, we use error messages to show what’s error. But 
for those logic errors, you should be careful by yourself. 
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� Error message during edition  
� Code –100: LABEL can’t be found 
There is no such LABEL that GOTO designates. 

� Code –101: recursion occurs  
This error message is usually occurred in sub-macro. The ability of a sub-macro 
to CALL itself is called recursion. No matter it is called directly or indirectly. 
Basically, recursion can’t be adopted for sub-macro. You can use GOTO or FOR 
(infinite times) to replace it. 

� Code –102 More than 3 nested FOR is used  
It is the limit for using nested FOR to avoid insufficient memory. You can use 
GOTO or IF to replace it. 

� Code –103 Sub-macro doesn’t exist  
It means there is no sub-macro in the program. For example, CALL 5 means 
CALL sub-macro 5. If you don’t edit sub-macro 5 in the program, you will get 
error message when editing to avoid unexpected error. 

� Code –104 Number of NEXT is less than the number of FOR 
The number of NEXT should be equal to the number of FOR. This error code is 
used to remind you finding out the missing NEXT. 

� Code –105 Number of FOR is less than the number of NEXT 
The number of FOR should be equal to the number of NEXT. This error code is 
used to remind you finding out the missing FOR. 

� Code–106  Repeated LABEL  
This means that there are repeated LABEL in the same Macro. The program will 
be confusing with that. That may be caused by careless and you will get error 
message during editing to avoid unexpected error. 

� Code–107 There is RET in Macro 
This means that there is RET command in Macro. RET command should be used 
for sub-macro to return program. But in Macro, it should use END not RET. 

� Code–108 The length of Macro CHR exceeds setting range 128 bytes 
This means that the length of macro CHR is out of range.  

� Code–109 Input error PLC 
This means the PLC you input is error. 

� Code–110 Input error recipe 
This means the recipe you input is error. 

� Code–111 The address of recipe exceeds setting range 
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This means the address of recipe you input is out of range. 

� HMI Macro Error Message 
You can read error message by Macro. Once there is an error and you execute a 
correct command before reading error message, the error message will be 
overwritten. When executing each Macro, each Macro error message won’t be 
influenced by other Macro. 

� Code–10 GOTO Error 
There is GOTO error in Macro. 

� Code–11 Stack Overflow  
It means that stack is full. That may be cause by using too many sub-macro or 
execute different macros at the same time. This is to avoid insufficient memory. 

� Code–12 CALL Empty Sub-macro  
This is CALL sub-macro error. The sub-macro that is called should not be an 
empty sub-macro. It is avoid unexpected error. 

� Code–13 Data Read Error  
This is PLC data read error. Sometimes this may also cause memory data error. 

� Code–14 Data Write Error  
This is PLC data write error. Sometimes this may also cause memory data error. 

� Code–15 Divisor is 0 
This error message means that your devisor is 0 when you do division. 

� HMI Communication Error Message  

 
Fig. 4-4-1 

� Communication Busy  
Error message: Com ? Station ?: Communication Busy ... 

� Unrecognized Code  
Error message: Com ? Station ?: Receive Unknow Code ... 

� No Response from Controller  
Error message: Com ? Station ?: Controller No Response ... 

� Check Sum Error in HMI  
Error message: Com ? Station ?: Check Sum Error in HMI Message ... 
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� Check Sum Error in Controller  
Error message: Com ? Station ?: Check Sum Error in Controller Message ... 

� Incorrect Command  
Error message: Com %d Station %d: Command Can Not be Executed ... 

� Incorrect Address  
Error message: Com ? Station ?: Address Fault ... 

� Incorrect Value  
Error message: Com ? Station ?: Value is Incorrect ... 

� Controller is Busy 
Error message: Com ? Station ?: Controller is Busy ... 

� CTS Signal Fail  
Error message: Com ? Station ?: CTS Signal Fail ... 

� No Such Resource  
Error message: Com ? Station ?: No Such Resource ... 

� No Such Service  
Error message: Com ? Station ?: No Such Service ... 

� Retry Again 
Error message: Com ? Station ?: Must Retry ... 

� HMI Station Number Error  
Error message: Com ? Station ?: HMI Station Number Error ... 

� Controller Station Number Error  
Error message: Com ? Station ?: Controller Station Number Error ... 

� UART Communication Error  
Error message: Com ? Station ?: UART Communication Error ... 

� Other Communication Error  
Error message: Com? Station ?: Other Communication Error ... 
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Chapter 5 System Control 
For two-way communication and display screen between DOP series and all brands’ 
PLC, it needs to define the address of HMI control register and state register. The 
settings are in Options > Model parameter. 

 
Fig. 5-1 Module parameter settings 
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Fig. 5-2 Communication settings 

5-1 Control Area  

The function in system control is the most important in DOP series. You can control 
HMI from PLC. You can designate the register from system control parameter 
settings. The register is a continuous data block and its length is from 0 to 8 WORDs. 
The length will be different by function. For example, it needs at least 8 WORDs for 
recipe function. Each WORD number explanation is in the following: 

Word  
Number 

Register Number 

0 Register for designated Screen Number (SNIR)  
1 Control Flag Register (CFR)  
2 Curve Control Register (CUCR)  
3 Control Flag Register for Sampling History Buffer (HBSR)  
4 Control Flag Register for Clearing History Buffer (HBCR)  
5 Recipe Control Register (RECR)  
6 Designated Recipe Number Register (RBIR)  
7 Control Flag Register 2 (CFR2)   
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� Register for Designated Screen Number (SNIR) 

Word Function 
0 Designate screen number for switching  

This register SNIR (Dn) can be used to designate HMI screen by setting PLC (D0). 
You can switch HMI screen automatically by changing D0. 

� Control Flag Register (CFR) 

Bit Number Function 
0 Reserved 
1 Turn off back light 
2 Turn off buzzer 
3 Clear alarm buffer 
4 Clear alarm counter 

5-7 Reserved 
8 Setting user level Bit0 
9 Setting user level Bit1 
10 Setting user level Bit2 

11-15 Reserved 
� Turn off back light  
Turns back light On/Off by PLC. When Bit 1 is set to On, it will turn off back light. 
When Bit 1 is set to Off, it will turn on back light.  

� Turn off buzzer  
Turns buzzer On/Off by PLC. When Bit 2 is set to On, it will turn off back light. 
When Bit 1 is set to Off, it will turn on back light. 

� Clear Control Flag for Alarm Buffer  
Controls to clear alarm buffer from PLC. It clears alarm buffer by setting bit3 of 
control flag to ON/OFF ONCE (about 1 second). 

� Clear Control Flag for Alarm Counter  
Controls to clear alarm counter from PLC. It clears alarm counter by setting bit4 
of control flag to ON/OFF ONCE (about 1 second). 

� Setting User Level 
PLC can set user level of using HMI from Bit 8, Bit 9 and Bit 10. The setting level 
is from level 0 to level 7. MSB: Bit 10 and LSB: Bit 8. 

� Curve Control Register (CUCR) 
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Bit Number Function 
0 Curve sampling flag 1 
1 Curve sampling flag 2 
2 Curve sampling flag 3 
3 Curve sampling flag 4 

4-7 Reserved 
8 Curve clear flag 1 
9 Curve clear flag 2 
10 Curve clear flag 3 
11 Curve clear flag 4 

12-15 Reserved 

� Curve Sampling Control Flag (1-4)  
HMI curve sampling is controlled by PLC. When Bit0—Bit3 of this curve 
sampling control flag is set to ON/OFF ONCE (about 1 second), HMI will sample 
ONCE by reading continuous data of curve graph and convert to graph to show 
with curve graph or XY curve graph. 

� Curve Clear Control Flag (1-4)  
Clears curve by PLC. When Bit8—Bit11 of this curve clear control flag is set to 
ON/OFF ONCE (about 1 second). 

� Control Flag Register for Sampling History Buffer (HBSR)  
Before setting, you should set the corresponding PLC address for 
communication. The data in buffer means save sampling data in HMI memory. 
You should set buffer address and length. 

 
Fig. 5-3 Buffer parameters settings (12 records, max.) 
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HMI provides 12 records for tracking sampling register of history buffer. Besides 
HMI time interval settings, sampling or clearing history buffer can be controlled 
by PLC. Each sample or clear control is controlled by 2 control registers. 

Bit Number Function 
0 Control flag for Sampling History Buffer 1 
1 Control flag for Sampling History Buffer 2 
2 Control flag for Sampling History Buffer 3 
3 Control flag for Sampling History Buffer 4 
4 Control flag for Sampling History Buffer 5 
5 Control flag for Sampling History Buffer 6 
6 Control flag for Sampling History Buffer 7 
7 Control flag for Sampling History Buffer 8 
8 Control flag for Sampling History Buffer 9 
9 Control flag for Sampling History Buffer 10 
10 Control flag for Sampling History Buffer 11 
11 Control flag for Sampling History Buffer 12 

12-15 Reserved 

� Control Flag Register for Clearing History Buffer  
Sampling method can be time interval or sample history trend graph by PLC. 
Once it triggers control flag to be ON (about 1 second), it will sample ONCE. But 
you should set this flag to be OFF when you need to trigger it again. 

 [Example] Delta PLC: 

(1) Consider that Control block is D0 and its length is 6. 

(2) The PLC corresponding address of Buffer #1 is D200. 

(3) Data length of buffer #1 is 3 WORDs. 

Therefore, PLC save records data in D200-D202 and set Bit 0 of D3 to be ON. 
When HMI detectes bit 0 is changed from OFF to ON, it will read data from 
D200-D202 in PLC automatically and save sampling data in HMI battery backup 
RAM. 

� Clear Register of History Buffer (HBCR) 
Bit Number Function 

0 Clear flag of history buffer 1 
1 Clear flag of history buffer 2 
2 Clear flag of history buffer 3 
3 Clear flag of history buffer 4 
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Bit Number Function 
4 Clear flag of history buffer 5 
5 Clear flag of history buffer 6 
6 Clear flag of history buffer 7 
7 Clear flag of history buffer 8 
8 Clear flag of history buffer 9 
9 Clear flag of history buffer 10 
10 Clear flag of history buffer 11 
11 Clear flag of history buffer 12 

12-15 Reserved 

� Clear signal of history buffer  
Clears HMI history trend graph by PLC. Once it triggers control flag to be ON 
(about 1 second), it will clear buffer ONCE. But you should set this flag to be OFF 
when you need to trigger it again. 

� Recipe Control Register (RECR) 
Bit Number Function 

0 Change recipe number  
1 Read recipe (PLC → HMI) 
2 Write recipe (HMI → PLC) 

3-15 Reserved 

� Control flag for writing recipe  
When writing a recipe to PLC, you should write recipe number (N) into control 
register (RNR) Dn+5 and then set bit #4 of control flag to be ON. But you should 
set this flag to be OFF when you need to trigger it again. 

For example: 

If you want to write recipe number 4 (RCPNo=4) into PLC, the write control bit 
will be bit 2 of D5 (D5=4). 

� Control flag for changing recipe number  
RCPNo is the internal system register used for designating recipe number. You 
can change RCPNo value by writing recipe number (N) into designated register 
of recipe number (RBIR) Dn+6 and set bit #0 of control flag in recipe number 
control register (RECR) to be ON (about 1 second). After setting, RCPNo will be 
changed to N and display the corresponding recipe data (RCPW0-RCPWm) of 
recipe number N. But you should set this flag to be OFF when you need to 
trigger it again. 

� Control flag for saving recipe to HMI  
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When you want to save recipe from PLC to HMI, you should write recipt number 
into designated register of recipe number (RBIR) Dn+6 and set bit #1 of control 
flag to be ON (about 1 second). But you should set this flag to be OFF when you 
need to trigger it again. 

For example: 

When you want to save recipe to recipe number 12 (RCPNo=12) from PLC, you 
should set bit #1 of D5 is ON (D5=2). 

� Designated Recipe Number Register (RBIR) 
Word Function 

0 Recipe number  

RCPNo is the internal system register used to control recipe number for 
displaying or transmit recipe back to HMI. In other words, you can transmit 
recipt to designated address by changing RCPNo. 

5-2 State 
For two-way communication and display screen between DOP series and all brands’ 
PLC, it needs to input start address of response register in state area. The state area 
in DOP series is a continuous data block, such as Dm=D10 (length is 7 WORDs = 
D10-D16). The function and explanation of each WORD are in the following: 

Word Number Register 
0 State Regsiter for General Control (GCSR) 
1 State Regsiter for Screen Number (SNSR) 
2 State Regsiter for Curve Control (CCSR) 
3 State Regsiter for Sampling History Buffer (HSSR) 
4 State Regsiter for Clearing History Buffer (HCSR) 
5 Recipe State Regsiter (RESR) 
6 State Regsiter for Recipe Number (RBSR) 

� General Control State Register (GCSR) 
Bit Number Function 

0 Screen Switch State  
1-2 Reserved 
3 Clear State of Alarm Buffer  
4 Clear State of Alarm Counter  

5-7 Reserved 
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Bit Number Function 
8 User Level (Bit0) 
9 User Level (Bit1) 
10 User Level (Bit2) 
11 User Level (Bit3) 

12-15 Reserved 

� Screen Swith State  
When Switching screen, the bit will be ON. After finishing switching, the bit will 
be OFF. 

� User Level State  
When HMI is in communication, the user level are in the following: 

User level 0 ==>bit8=Off, bit9=Off, bit10=Off 
User level 1 ==>bit8=ON, bit9=Off, bit10=Off  
User level 2 ==>bit8=Off, bit9=ON, bit10=Off 
User level 3 ==>bit8=ON, bit9=ON, bit10=Off  
User level 4 ==>bit8=Off, bit9=Off, bit10=ON  
User level 5 ==>bit8=ON, bit9=Off, bit10=ON 
User level 6 ==>bit8=Off, bit9=ON, bit10=ON  
User level 7 ==>bit8=ON, bit9=ON, bit10=ON  
User level 8 ==>bit8=Off, bit9=Off, bit10=Off, bit11=ON 

 
� State Register for Screen Number (SNSR) 

Word Function 
0 The last screen number you opened  

� The last screen number you opened 
The register SNSR (Dm) is used to save the last screen number you opened. 
After switching screen, it will send current screen number to save in state 
register (Dm).  

� State Register of Curve Control (CCSR) 
Bit Number Function 

0 Sample state of curve 1  
1 Sample state of curve 2  
2 Sample state of curve 3 
3 Sample state of curve 4 
8 Clear state of curve 1 
9 Clear state of curve 2 
10 Clear state of curve 3 
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11 Clear state of curve 4 
4-7;12-15 Reserved 

� Clear State of Curve  
 

When controlling to clear curve graph or XY curve graph by PLC, clear state 
contact (D12) Bit08--Bit11 will be set to be ON after clearing. When clear control 
flag D2 (bit08-11) is OFF, clear state contact will also be OFF.  

� Sample State Contact of Curve Graph  
When controlling to sample curve graph or XY curve graph by PLC, sample state 
contact (D12) Bit0—Bit3 will be set to be ON after sampling. When sample 
control flag D2 (bit0-3) is OFF, sample state contact will also be OFF.  

� Sample State Register of History Buffer (HSSR) 
Bit Number Function 

0 Sample State of History Buffer 1  
1 Sample State of History Buffer 2  
2 Sample State of History Buffer 3 
3 Sample State of History Buffer 4 
4 Sample State of History Buffer 5 
5 Sample State of History Buffer 6 
6 Sample State of History Buffer 7 
7 Sample State of History Buffer 8  
8 Sample State of History Buffer 9 
9 Sample State of History Buffer 10 
10 Sample State of History Buffer 11 
11 Sample State of History Buffer 12 

12-15 Reserved 

� Sample State of Trend Graph  
When controlling to sample trend graph by PLC, sample state contact (D3) Bit 
#0--#11 will be set to be ON after sampling. When sample control flag D13 is OFF, 
sample state contact of trend graph will also be OFF.  

� Clear State Register of History Buffer (HCSR) 
Bit Number Function 

0 Clear State of History Buffer 1  
1 Clear State of History Buffer 2 
2 Clear State of History Buffer 3 
3 Clear State of History Buffer 4 
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Bit Number Function 
4 Clear State of History Buffer 5 
5 Clear State of History Buffer 6 
6 Clear State of History Buffer 7 
7 Clear State of History Buffer 8 
8 Clear State of History Buffer 9 
9 Clear State of History Buffer 10 
10 Clear State of History Buffer 11 
11 Clear State of History Buffer 12 

12-15 Reserved 

When controlling to clear trend graph by PLC, clear state contact (D14) Bit 
#0--#11 will be set to be ON after clearing. When clear control flag D4 is OFF, 
clear state contact of trend graph will also be OFF. 

� Recipe State Register (RESR) 
Bit Number Function 

0 Change State of Recipe Number  
1 Recipe Read State (PLC → HMI)  
2 Recipe Write State (HMI → PLC)  

3-15 Reserved 

� State Contact for reading recipe  
After transmitting recipe from PLC to HMI, recipe state contact BIT#1 (D6 bit1) 
will set to be ON automatically. When recipe control flag is OFF (D16 bit1), the 
state contact for reading recipe (BIT#1) will also be OFF.  

� State contact for changing recipe number  
When control flag of recipe number BIT#0 (D6 bit0) is set to ON, state contact for 
changing recipe number (RCPNo) BIT#0 (D16 bit0) will be set to ON and it will be 
OFF after changing.  

� State contact for writing recipe  
After transmitting recipe from HMI to PLC, recipe state contact BIT#2 (D16) will 
set to be ON automatically. When recipe control flag is OFF (D6 bit2), the state 
contact for reading recipe (BIT#2) will also be OFF. 

� State Register for Recipe Number (RBSR) 
Word Function 

0 Current recipe number  

When recipe number register RCPNo is changed by PLC or HMI, state register of 
recipe number (RBSR) (Dm+6) will be updated. Monitoring this recipe number 
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register for designer to confirm current recipe number. 

5-3 Internal Memory  
� Internal Register (R/W) : $ 

Word access: $n (n: 0~65535) 
Bit access: $n.b (n: 0~65535, b: 0~15) 
There are 65536 16-bit registers ($0 ~ $65535) in HMI.   

� Non-volatile register (R/W) : $M  
Word access: $Mn (n: 0~1023) 
Bit access: $Mn.b (n: 0~1023, b: 0~15) 
There are 1024 16-bit registers ($0 ~ $1023) in HMI. 

� Control Register (R): CTRL 
Word read: CTRLn (n: 0~ control area size -1) 
Bit Read: $CTRL.b (n: 0~ control area size –1, b: 0~15) 
The control register for HMI to save data after reading from control area of PLC 
or other device. This control register is read only. The control register size is the 
same as control area that set during editing screen. 

� Recipe Number Register (R/W): RCPNO 
It is 16-bit register that used to designate recipe number. The range of recipe 
number is from 1 to 64K(total recipe numbers). Total recipe number is set when 
editing recipe. 
PLC upload/download is read/write a recipe according to the setting of recipe 
number register. The recipe length is set during editing recipe. 

� Recipe Register (R/W): RCPn  
The recipe register is used to save the recipe that download from HMI after 
finishing screen edition. There are two methods for read/write these registers: 
Consider that recipe length is L and total recipe number is N, 

1. Recipe number access: this method is accessed by RCPNO and RCP0~RCP 
(L-1). For example: if RCPNO=3, HMI will read RCPNO 3 data out and save it in 
RCP0~RCP (L-1). Then PLC can read RCPNO 3 data from this area. RCP0~RCP 
(L-1) can be regarded as a common area. 

2. Absoluted address access: it is used to access the data that data address is 
greater than RCP (L-1). At this time, the start address of 1st recipe is RCP (1XL), 
the start address of 2nd recipe is RCP (2XL) and so on. Therefore, if you want 
to access the mth word of nth recipe. RCP will be (nxL+m). 
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RCP0 RCP1 RCP2 RCP (L-1)...

1xL 1xL+1 1xL+2 1xL+(L-1)
2xL 2xL+1 2xL+2

...

...

...

2xL+(L-1)

...

NxL NxL+1 NxL+2 NxL+(L-1)

RCP0=1
RCP0=2

RCP0=N

RCP0=X; (1<=X<=N)
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Appendix A Installation  

A-1 Specification 
Model DOP-A57GSTD DOP-A57CSTD DOP-A75CSTD DOP-A10TCTD Remark

Operation System Windows Base Real Time OS  
MCU 32-bit RISC Micro-controller / 202.8MHz  
ROM NOR Flash ROM 4 Mbytes (System: 1MB / User: 3MB)  

SDRAM 16Mbytes 32Mbytes  
Backup Memory 

(SRAM) 256Kbytes(non-volatile internal memory)  

EXT. Memory Card Smart Media Card (Windows®98/Me/2000/XP FAT Compatible) ※ 
USB for download 1 CLIENT Ver 1.1  

Serial 
communication 

(UART) 
COM1: RS-232C ;  COM2: RS-232C/422/485  

LCD MODULE 

5.7＂FSTN LCD  
(16grays) 
320 x 240 pixels 
CCFL Back Light 

5.7＂Color STN 
LCD (256 colors)
320 x 240 pixels
CCFL Back Light

7.5＂Color STN  
LCD (256 colors) 
640 x 480 pixels 
2CCFL Back Light

10.4＂Color TFT 
LCD (256 colors) 
640 x 480 pixels 
2CCFL Back Light

 

Display Size  
W x H (mm) 

Viewing Area 

5.7＂ 
(118.2 x 89.4) 

7.5＂ 
(158.0 x118.0) 

10.4＂ 
(215.2 x 162.4)  

Auxiliary Keys 
(Touch screen 

width) 
User defined key *4 User defined key 

*5 
User defined key 

*6  

Touch Panel Size 6.4＂ 8.2＂ 11.0＂  
RTC Built-in  

Lithium Battery CR2032 x 1  
Buzzer 85dB  

Power 
Consumption DC +24V (-10%~+20%)/ 7.2W max

DC +24V 
(-10%~+20%)/10W 

max 

DC +24V 
(-10%~+20%)/15W 

max 
 

Cooling Method Natural air circulation  
Water Proof NEMA4  

Operating Temp. 0℃ to 50℃  
Storage Temp. -20℃ to +60℃  

Ambient Humidity 10% ~ 90% RH  

Vibration 
Resistance 

IEC61131-2 compliant 
When vibration is NOT continuous: 10Hz-57Hz 0.0075mm, 57Hz-150Hz 1G

When vibration is continuous: 10Hz-57Hz 0.0035mm, 57Hz-150Hz 0.5G  
X, Y, Z directions for 10 times 

 

(W) x (H) x (D) mm 
External 

Dimensions 
184.1 x 144.1 x 46.9 243.1 x 178.1 x 47 297.1 x 222 x 51.1  

Weight 650g 950g 1420g  
※ compatible with general Expansion Memory Card (4M~128M) on the market 
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A-2 Dimension 
� DOPA57GSTD 
Vertical View -- Unit: mm(inch) 

 
 

Front Panel -- Unit: mm(inch) Right Side Diagram -- Unit: mm(inch)

  
 
� DOPA75CSTD 
Vertical View -- Unit: mm(inch) 

 
 
Front Panel -- Unit: mm(inch) Right Side Diagram -- Unit: mm(inch) 

 
 
� DOP-A10TCTD 
Vertical View -- Unit: mm(inch) 
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Front Panel -- Unit: mm(inch) Right Side Diagram -- Unit: mm(inch) 

 
 

A-3 Profile 

DOP-A57G (C) STD 

A Display area 
B Touch screen 
C Power LED State  
 Dark LED: power is off. 
 Green LED: normal operation

D Power input terminal  
E Expansion slot 
F Memory card 
G COM 2 
H COM 1 
I USB 
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DOP-A75CSTD 

 Name 
A Display area 
B Touch screen 
C Power LED State  
 Dark LED: power is off 
 Green LED: normal 

operation 
D Power input terminal 
E Expansion slot 
F Memory card 
G COM 2 
H COM 1 
I USB 

 
 

 
DOP-A10TCTD 

 Name 
A Display area 
B Touch screen 
C Power LED State  
 Dark LED: power is off. 
 Green LED: normal 

operation 
D Power input terminal  
E Expansion slot 
F Memory card  
G COM 2 
H COM 1 
I USB 
J Battery cover 
  
  
  
  

 

A-4 Cutout dimension 

5.7":172.4mm (6.79") +1mm (0.04") and 132.4mm (5.21")+1mm (0.04")   unit: mm 
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(inch) 

Panel thickness: 1.6mm (0.06in)~5.0mm (0.20in) 

  
 
7.5": 231.4mm (9.11")+1mm (0.04") and 166.4mm (6.55")+1mm (0.04")      unit: mm 
(in.) 

Panel thickness: 1.6mm (0.06in)~5.0mm (0.20in) 

  
10.4": 285.2mm (11.22")+1mm (0.04") and 210.2mm (8.27")+1mm (0.04") 
Panel thickness:  1.6mm (0.06in)~5.0mm (0.20in) 

Snap-in panel mount 

Snap-in panel mount 
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A-5 Installation  

CAUTION! If you turn the screw exceeds torque: 0.5N.M, plastic box may be 
damaged.  

5.7” Panel (DOP-A57GSTD, DOP-A57CSTD) 

 

7.5” Panel (DOP-A75CSTD) 

 

10.4” Panel (DOP-A10TCTD) 

Snap-in panel mount
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Appendix B  Communication  
B-1 Pin definition of serial communication  
COM1 

Pin Contact 

1 N.C. 

2 RXD 

3 TXD 

4 N.C. 

5 GND 

6 N.C. 

7 RTS 

8 CTS 

 

9 N.C. 

 

COM2 
MODE1 MODE2 MODE3 

Pin
RS-232 RS-422 RS-485 

1 N.C. RXD- D- 

2 RXD RXD+ D+ 

3 TXD TXD+ D+ 

4 N.C. TXD- D- 

5 GND GND GND 

6 N.C. RTS- N.C. 

7 RTS RTS+ N.C. 

8 CTS CTS+ N.C. 

 

9 N.C. CTS- N.C. 

Note: 
n Mode 3 is for RS-485. Pin 2&3 are D+ and pin 1&4 are D-.  
n It is recommended to have great grounding when using RS-485 & RS-422 for long 

transmission.  
n DO NOT connect Frame Ground (FGND) to GND. Please connect FGND to the outer 

covering of connector.  
n There are relations among transfer rate, distance and baud rate.  

 

Pin1

Pin1 
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Pin1

B-2 Cable for download  
The cable header used to connect DOP series is 9-pin D-SUB male.  
 

 

Refer following cable header and jumper for connecting to each device. 
RS-232 

DOP series 
9 pin D-SUB male (RS-232) 

PC  
9 pin D-SUB female 

(RS-232) 

PC  
9 pin D-SUB female 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND

RTS (7) (8) CTS

CTS (8) (7) RTS  

 
 
 
 
 
 
 

 

 
Grounding + Shielding 

Fig. RS232 TO PC 
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USB TYPE B to DOP series                          USB TYPE A to PC 

 

Fig. USB TO PC 
 
B-3 Communication setting and wiring between HMI and supported 

controller 
Item Controller 

Delta Controller 
For Servo/Inverter/Temperature Controller/PLC 
(984 RTU mode / ASCII mode) Delta 

DVP PLC 

Allen Bradley MicroLogix PLC 
Facon Facon PLC 
Festo Festo PLC 

Hust HUST_CNC 

Koyo SU/DL Series 

LG Master-K120S/200S 

LI YAN LYPLC EX 

Matsushita FP Series 
Mirle FAMA SC 

Mitsubishi FX / FX2N 

Modbus (Master) --- 984 RTU / ASCII mode 
Modbus 

Modbus (Slave) --- 984 RTU / ASCII mode 

Modicon TSX Micro 

Omron Omron C Series 

S7 200 
Siemens 

S7-300 (with PC Adapter) 
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Item Controller 
Taian TP02 

Yokogawa ACE PLC 

Delta Controller 
A. HMI factory setting 

Baud rate: ASCII: 9600, 7, None, 2.  
RTU: 9600, 8. None, 2 
Controller station number: 1. 
Control area/state area: None. 

B. Definition of controller Read/Write address 
1. Registers 

Read/Write range Register type Device Name Format Word No. Bit No.
Data 

length 
Servo 
communication 
address 

0x00 SERVO-n n: 0-0600h 0 Word 

Inverter 
communication 
address 

0x01 INVERTER-n n: 0-2199h 0 Word 

TCntrl 
communication 
address 

0x02 TEMP_CTRL-n n: 
4700h-4800h 0 Word 

WORD_DEVICE_X 0x03 PLC_Xn n: 0-360(octal) 0 Word 
WORD_DEVICE_Y 0x04 PLC_Yn n: 0-360(octal) 0 Word 
WORD_DEVICE_M 0x05 PLC_Mn n: 0-1520, 0 Word 

   1536-4080 0 Word 
WORD_DEVICE_S 0x06 PLC_Sn n: 0-1008 0 Word 
WORD_DEVICE_T 0x07 PLC_Tn n: 0-255 0 Word 
WORD_DEVICE_C 0x08 PLC_Cn n: 0-127 0 Word 
WORD_DEVICE_D 0x09 PLC_Dn n: 0-4095, 0 Word 

   4096-9999 0 Word 

WORD_DEVICE_HC 0x0A PLC_Cn n: 232-255 0 Double 
Word 

Note: 
A. Above addresses is hexadecimal system. (SERVO: 0-0600, INVERTER: 0-2199, 

TCNTRL (Temperature controller): 4700-4800.) 
B. WORD_DEVICE_ X / WORD_DEVICE_Y / WORD_DEVICE_M / WORD_DEVICE_S: data 

length must be 0 or the multiple of 16. 
 
2. Contacts 
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Read/Write range 
Contact type 

Devic
e 

Name
Format Word No. Bit No. 

Servo communication 
address 

0x80 SERVO-n.b n: 0-0600h b: 0-f 

Inverter communication 
address 

0x81 INVERTER-n.b n: 0-2199h b: 0-f 

TCntrl communication 
address 

0x82 TEMP_CTRL-n.
b 

n: 
4700h-4800h 

b: 0-f 

Servo Digital Input 0x83 SERVO_DI-n 0 n: 1-8 
Servo Digital Output 0x84 SERVO_DO-n 0 n: 1-5 
PLC X 0x85 PLC_Xn 0 n: 0-377(octal) 
PLC Y 0x86 PLC_Yn 0 n: 0-377(octal) 
PLC M 0x87 PLC_Mn 0 n: 0-1535 
   0   1536-4095 
PLC S 0x88 PLC_Sn 0 n: 0-1023 
PLC T 0x89 PLC_Tn 0 n: 0-255 
PLC C 0x8A PLC_Cn 0 n: 0-127 

Above addresses is hexadecimal system. (SERVO: 0-0600, INVERTER: 0-2199, 
TCNTRL(Temperature controller): 4700-4800.) 
DI and DO are only for Servo. 
Note: 

1. For Delta Inverter:  
It needs to set communication address for HMI read/write address setting. 
(hexadecimal system for HMI) 
Example 1: in Delta VFD-S type parameter 5-00 1st step speed frequency. You need 
to set INVERTER500 in HMI. (5 is converted to 05 (hexadecimal) and 00 is 
converted to 00 (hexadecimal). Therefore, you should set INVERTER500 to HMI 
with discarding the first 0). 
Example 2: if you want to set parameter 8-17 (lower bound of DC braking startup 
frequency of Delta VFD-S type, you should set INVERTER811 in HMI). (8 is 
converted to 08 (hexadecimal) and 17 is converted to 11 (hexadecimal). Therefore, 
you should set INVERTER811 to HMI with discarding the first 0) 

2. For Delta Servo / Delta Temperature Controller: 
a. HMI Read/Write address setting: you only need to input communication address 

in SERVO user manual. 
b. DI and DO are only for Servo. 

 
C. Controller Wiring 
� Delta Servo 
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RS-232 
DOP Series 

9 pin D-SUB male (RS-232) 
Controller 

CN3 male (RS-232) 
Controller 

CN3 male (RS-232) 

RXD (2) (2) TX

TXD (3)

GND (5)

(4) RX

(1) GND 

 
1 

2 

3 5

4 6
Top View  

 
RS-422 

DOP Series 
9 pin D-SUB male (RS-422) 

Controller 
CN3 male (RS-422) 

Controller 
CN3 male (RS-422)

RXD+ (2) (5) TX+

RXD- (1)

TXD+ (3)

(6) TX-

(3) RX+

TXD- (4) (4) RX-  

 
1 

2 

3 5

4 6
Top View  

 
RS-485 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller 
CN3 male (RS-485) 

Controller 
CN3 male (RS-485)

RXD+ (2) (3) 485+

TXD- (3)

RXD- (1)

(5) 485-

(4) 485+

TXD- (4) (6) 485-  

 
1 

2 

3 5

4 6
Top View  

� Delta Inverter 
RS-485 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller  
RJ-11 (RS-485) 

Controller  
RJ-11 (RS-485) 

RXD+ (2) (4) SG+

TXD- (3)

RXD- (1)

TXD- (4) (3) SG-  

 

Top View

1  +EV
2  GND
3  SG-
4  SG+

Pin 1 and 2 are the power sources 
for the optional keypad and should 
not be used while using RS-485 
communication.

1 - 6
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� Temperature Controller 
RS-485 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller 
RS-485 

RXD+ (2) D+

TXD- (3)

RXD- (1)

TXD- (4) D-  

 
Delta_PLC  
A. HMI factory settings 

Baud rate: 9600, 7, Even, 2. 
Controller station number: 1. 
Control area/state area: D0 / D10. 
 

B. Definition of controller Read/Write address 
1. Registers 

Read/write range Register type Device 
Name Format Word No. Bit No. 

Communication
-Base address

X_Data 0x00 Xn n: 0-360(octal) None 0x0400 (W) 
Y_Data 0x01 Yn n: 0-360(octal) None 0x0500 (W) 
M_Data 0x02 Mn n: 0-1520, None 0x0800 (W) 

   1536-4080  0xB000 (W) 
S_Data 0x03 Sn n: 0-1008 None 0x0000 (W) 

T_Register 0x04 Tn n: 0-255 None 0x0600 (W) 
C_Register 0x05 Cn n: 0-127 None 0x0E00 (W) 
D_Register 0x06 Dn n: 0-4095, None 0x1000 (W) 

   4096-9999  0x9000 
HC_Register 0x07 Cn n: 232-255 None 0x0E00 (DW) 

Note: a. (W) is “Word”. 
b. (DW) is “Double Word”. 
c. X_Data / Y_Data / M_Data / S_Data: it must be 0 or the multiple of 16.  

2. Contacts 
Read/write range  Contact type Device 

Name Format Word No. Bit No. 
Communication
-Base address

X_Data 0x80 Xn None n: 0-377(octal) 0x0400 (W) 
Y_Data 0x81 Yn None n: 0-377(octal) 0x0500 (W) 
M_Data 0x82 Mn None n: 0-1520, 0x0800 (W) 

      1536-4080 0xB000 (W) 
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Read/write range  Contact type Device 
Name Format Word No. Bit No. 

Communication
-Base address

S_Data 0x83 Sn None n: 0-1023  
T_Coil 0x84 Tn None n: 0-255  
C_Coil 0x85 Cn None n: 0-255  

 
C. Controller Wiring 
RS-232 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller 
8 pin Mini DIN male (RS-232) 

Controller 
8 pin Mini DIN male 

(RS-232) 

RXD (2) (5) TXD

TXD (3)

GND (5)

(4) RXD

(8) GND 

 1
45 

8 

Top View  
 
RS-485 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller 
RS-485 

RXD+ (2) D+

TXD- (3)

RXD- (1)

TXD- (4) D-  

 

AllenBradley--MicroLogixPLC                           DELTA 
A. HMI factory setting 

Baud rate: 19200, 8, none, 1. 
PLC station number: 1. 
Control area/state area: B3:0/B3:10. 

B. Definition of controller Read/Write address 
1. Registers 
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Read/write range 

Bit No. 
Register type Device 

Name Format Word No. Low Byte (High Byte, 
File No.) 

Output file 0x40 O:n n: 0-3 0 0 
Input file 0x41 I:n n: 0-3 0 1 
Status file 0x42 S2:n n: 0-65 0 2 
Bit file 0x43 B3:n n: 0-255 0 3 
Timer flag 0x44 T4:n n: 0-255 0 4 
Timer Preset Value 0x45 T4:n.PRE n: 0-255 0 4 
Timer Accumulator 
Value 0x46 T4:n.ACC n: 0-255 0 4 

Counter flag 0x47 C5:n n: 0-255 0 5 
Counter Preset 
Value 

0x48 C5:n.PRE n: 0-255 0 5 

Counter 
Accumulator Value 0x49 C5:n.ACC n: 0-255 0 5 

Control file 0x4A R6:n n: 0-255 0 6 
Control Size of Bit 
Array 0x4B R6:n.LEN n: 0-255 0 6 

Control Reserved 
file 

0x4C R6:n.POS n: 0-255 0 6 

Integer file 0x4D N7:n n: 0-255 0 7 
Data Size: Word. 
T4, C5 and R6 only read 1 word once. 
If reading multiple WORDs once, the communication speed of PLC will be slowly. 
Note: If last communication data has memorized by PLC(PLC will inquire 0x10 0x05 
continuously), communication may be fail. At this time, power off and power up HMI or 
power off and power up PLC once. 
 
2. Contacts 

Read/write range 
Bit No. 

LowByte HighByteContact Type Device 
Name Format Word No.

Bits File No.
Output 0xC0 O:n/b n: 0-3 b: 0-15 0 
Input  0xC1 I:n/b n: 0-3 b: 0-15 1 
Status 0xC2 S2:n/b n: 0-65 b: 0-15 2 
Bit 0xC3 B3:n/b n: 0-255 b: 0-15 3 
Timer 0xC4 T4:n/b n: 0-255 b: 0-15 4 
  T4:n/EN n: 0-255 15  
  T4:n/TT n: 0-255 14  
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Read/write range 
Bit No. 

LowByte HighByteContact Type Device 
Name Format Word No.

Bits File No.
  T4:n/DN n: 0-255 13  
Timer Preset Value 0xC5 T4:n.PRE/b n: 0-255 b: 0-15 4 
Timer Accumulator 
Value 0xC6 T4:n.ACC/b n: 0-255 b: 0-15 4 

Counter flag 0xC7 C5:n/b n: 0-255 b: 0-15 5 
  C5:n/CU n: 0-255 15  
  C5:n/CD n: 0-255 14  
  C5:n/DN n: 0-255 13  
  C5:n/OV n: 0-255 12  
  C5:n/UN n: 0-255 11  
  C5:n/UA n: 0-255 10  
Counter Preset 
Value 0xC8 C5:n.PRE/b n: 0-255 b: 0-15 5 

Counter 
Accumulator Value 0xC9 C5:n.ACC/b n: 0-255 b: 0-15 5 

Control 0xCA R6:n/b n: 0-255 b: 0-15 6 
  R6:n/EN n: 0-255 15  
  R6:n/DN n: 0-255 13  
  R6:n/ER n: 0-255 11  
  R6:n/UL n: 0-255 10  
  R6:n/IN n: 0-255 9  
  R6:n/FD n: 0-255 8  
Control Size of Bit 
Array 0xCB R6:n.LEN/b n: 0-255 b: 0-15 6 

Control Reserved 0xCC R6:n.POS/b n: 0-255 b: 0-15 6 
Integer 0xCD N7:n/b n: 0-255 b: 0-15 7 

Bit No :  
Low byte stores bit address.  
High byte stores file number. 
 
3. Controller Wiring 
RS232 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller 
8 pin Mini DIN male 

(RS-232) 

Controller 
8 pin Mini DIN male 

(RS-232) 
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RXD (2) (7) TXD

TXD (3)

GND (5)

(4) RXD

(2) GND

(3) RTS

(6) CTS  

 1 
4 3
7 

2 

6

Top View  

Facon PLC                                                               DELTA  
A. HMI factory settings  

Baud rate: 9600, 7, Even, 1. 
Controller Station number: 1. 
Control area/state area: R0 / R10. 

 

B. Definition of controller Read/Write address 
1. Registers 

Read/write range Register type Device 
Name Format Word No. Bit No. Data length

Input Relay 0x00 WXn n: 0-9992 None Byte 
Output Relay 0x01 WYn n: 0-9992 None Byte 
Internal Relay 0x02 WMn n: 0-9992 None Byte 
Step Relay 0x03 WSn n: 0-9992 None Byte 
Data Register 0x04 Rn n: 0-65534 None Word 
Data Register 0x05 Dn n: 0-65534 None Word 
Timer Present Value 0x06 RTn n: 0-9999 None Word 
Counter Present 
Value 

0x07 RCn n: 0-9999 None Word 

Data Register 0x08 DRCn n: 200-255 None Double 
Word 

Input Relay / Output Relay / Internal Relay / Special Relay: it must be the multiple of 8. 
 

2. Contacts 
Read/write range Contact type Device 

Name Format Word No. Bit No. 
Input Relay 0x80 Xn None n: 0-9999 
Output Relay 0x81 Yn None n: 0-9999 
Internal Relay 0x82 Mn None n: 0-9999 
Step Relay 0x83 Sn None n: 0-9999 
Timer Flag 0x84 Tn None n: 0-9999 
Counter Flag 0x85 Cn None n: 0-9999 

C. Controller wiring 
RS-232 
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DOP Series 

9 pin D-SUB male (RS-232) 
Controller 

15 pin male (RS-232) 
Controller 

15 pin male (RS-232)
RXD (2) (2) TXD

TXD (3)

GND (5)

(1) RXD

(6) SG

(3) RTS

(4) CTS  

 6 2 1
14 13

Top View

 
Festo PLC                                                               DELTA 
 
A. HMI factory settings  

Baud rate: 9600, 7, Even, 1. 
Controller Station number: 0. (no PLC station number in protocol) 
Control area/state area: R0 / R10. 
Note: 1. Communication port of PLC: COM port 

2. It needs to use the specific cable of FESTO (the cable for transfer TTL 
to RS232) (FC34) 

 

B. Definition of controller Read/Write address 
1. Registers 

Register type Format Word No. Bit No. Data Size 

WORD_DEVICE_IW IWn n: 0-255 None Word 

WORD_DEVICE_OW OWn n: 0-255 None Word 
WORD_DEVICE_FW FWn n: 0-9999 None Word 

WORD_DEVICE_TW TWn n: 0-255 None Word 

WORD_DEVICE_CW CWn n: 0-255 None Word 

WORD_DEVICE_R Rn n: 0-255 None Word 

WORD_DEVICE_TP TPn n: 0-255 None Word 

WORD_DEVICE_CP CPn n: 0-255 None Word 
 

2. Contacts 
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Register type Format Word No. Bit No. 
BIT_DEVICE_I In.b n: 0-255 b: 0-15 

BIT_DEVICE_O On.b n: 0-255 b: 0-15 

BIT_DEVICE_F Fn.b n: 0-9999 b: 0-15 

BIT_DEVICE_T Tn None n: 0-255 

BIT_DEVICE_C Cn None n: 0-255 

BIT_DEVICE_TON TONn None n: 0-255 

BIT_DEVICE_TOFF TOFFn None n: 0-255 

BIT_DEVICE_T / BIT_DEVICE_C / BIT_DEVICE_TON / BIT_DEVICE_TOFF: Only 1 BIT for 
each communication. 
Only 1 BIT or 1 WORD for read/write (each communication). 
 
C. Controller wiring 

It needs to use the specific cable of FESTO (the cable for transfer TTL to RS232 and 
it is 6 pin at PLC side) (FC34) 

 
HUST CNC                                                               DELTA 
A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 2. 
Controller station number: 0. 
Control area/state area: W0 / W10. 

 
B. Definition of controller Read/Write address 

1. Registers 

Read/write range 
Register type Device 

Name Format
Word No. Bit No. 

Communication 
-base address 

Data 
Length 

Word Register 0x00 Wn n: 
0-13500 None 0 Word 

Double Word 
Register 0x01 Dn n: 

0-13500 None 0 Double 
Word 

Note: the unit for Hust CNC is Dword and Wn is the low word of Dn. 
 

2. Contacts 
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Read/write range 

Contact type Device 
Name Format

Word No. Bit No. 

Communication
-base address

BIT_DEVICE_B 0x80 Bm.n m: 0-13500 n: 0-31 0 
BIT_DEVICE_I 0x81 In None n: 0-255 (8 DW) 10800 
BIT_DEVICE_O 0x82 On None n: 0-255 (8 DW) 10808 
BIT_DEVICE_C 0x83 Cn None n: 0-255 (8 DW) 10816 
BIT_DEVICE_S 0x84 Sn None n: 0-255 (8 DW) 10824 
BIT_DEVICE_A 0x85 An None n: 0-1023 (32 DW) 10832 

 
C. Controller wiring 
RS-232 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller  
9 pin D-SUB male (RS-232) 

Controller  
9 pin D-SUB male 

(RS-232) 
RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(5) SG

(8) RTS

(7) CTS  

Top View

 
Koyo SU/DL Series                                                       DELTA 
A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1. 
Controller station number: 1. 
Control area/state area: V1400 / V1410. 

 
B. Definition of controller Read/Write address 
1. Registers 

Read/write range 
Register type Format 

Word No. Bit No. 
Data 

Length 
Timer Accumulated Vn n: 0 ~ 177 (octal) 0 Word 

Counter Accumulated Vn n: 1000 ~ 1177 (octal) 0 Word 

V Memory Vn n:  1400 ~ 7777 (octal) 0 Word 
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Read/write range 
Register type Format 

Word No. Bit No. 
Data 

Length 
Linker Relays Vn n: 40000 ~ 40037 (octal) 0 Word 

Input Status Vn n: 40400 ~ 40423 (octal) 0 Word 

Output Status Vn n: 40500 ~ 40523 (octal) 0 Word 

Control Relays Vn n: 40600 ~ 40635 (octal) 0 Word 

Stage Vn n: 41000 ~ 41027 (octal) 0 Word 

Timer Status Vn n: 41100 ~ 41107 (octal) 0 Word 

Counter Status Vn n: 41140 ~ 41147 (octal) 0 Word 

Spec. Relay 1 Vn n: 41200 ~ 41205 (octal) 0 Word 

Spec. Relay 2 Vn n: 41216 ~ 41230 (octal) 0 Word 

2. Contacts 
Read/write range 

Contact type Format 
Word No. Bit No. 

 Linker Relays  GXn 0 n: 0 ~ 777 (octal) 
 Input Status  Xn 0 n: 0 ~ 477 (octal) 
 Output Status  Yn 0 n: 0 ~ 477 (octal) 
 Control Relays  Cn 0 n: 0 ~ 737 (octal) 
 Stage  Sn 0 n: 0 ~ 577 (octal) 
 Timer Status  Tn 0 n: 0 ~ 177 (octal) 
 Counter Status  CTn 0 n: 0 ~ 177 (octal) 
 Spec. Relay 1  SPn 0 n: 0 ~ 137 (octal) 
 Spec. Relay 2  SPn 0 n: 320 ~ 617 (octal) 

C. Controller wiring 
RS-232 
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DOP  

9 pin D-SUB male (RS-232) 
Controller  

RJ-11 (RS-232) 
Controller  

 
RXD(2)

TXD(3)

GND(5)

(4)TXD

(3)RXD

(1)GND

(6)GND 

 

Top View
1 - 6

 

 
 
LG Master K120S/200S                                                  DELTA 
 
A. HMI factory settings 

Baud rate: 38400, 8, None, 1. 
Controller station number: 0.  
(Note: it can’t designate PLC station, only one PLC can be communicated) 
Control area/state area: DT0 / DT10. 

 
B. Definition of controller Read/Write address 
1. Registers 

Register type Format Word No. Bit No. Data Size

WORD_DEVICE_PW PWn n: 0-15 None Word 

WORD_DEVICE_MW MWn n: 0-191 None Word 

WORD_DEVICE_KW KWn n: 0-31 None Word 

WORD_DEVICE_LW LWn n: 0-63 None Word 

WORD_DEVICE_FW FWn n: 0-63 None Word 
WORD_DEVICE_TW TWn n: 0-255 None Word 

WORD_DEVICE_CW CWn n: 0-255 None Word 

WORD_DEVICE_DW DWn n: 0-9999 None Word 

2. Contacts 
Contact type Format Word No. Bit No. 

BIT_DEVICE_P Pnb n: 0-15 b: 0-f 

BIT_DEVICE_M Mnb n: 0-191 b: 0-f 
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BIT_DEVICE_K Knb n: 0-31 b: 0-f 

BIT_DEVICE_L Lnb n: 0-63 b: 0-f 

BIT_DEVICE_F Fnb n: 0-63 b: 0-f 

BIT_DEVICE_T Tn None n: 0-255 
BIT_DEVICE_C Cn None n: 0-255 

 
D. Controller wiring 
RS-232 
 

DOP  
9 pin D-SUB male (RS-232) 

Controller  
9 pin D-SUB male  

(RS-232 for LG K120S/200S) 

Controller  

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND 
 

 
 
 
 
 
 

Top View 
 
LIYAN LYPLC EX                                                        DELTA 
A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 1. 
Controller station number: 0. 
Control area/state area: D0 / D10. 

 
B. Definition of controller Read/Write address 
1. Registers 

Read/write range 
Register type Format 

Word No. Bit No. 
Data length 

Auxiliary Relay Mn n: 0-3064 None Byte 

Special Auxiliary Relay Mn n: 8000-8248 None Byte 

Status Relay Sn n: 0-992 None Byte 

Input Relay Xn n: 0-360(octal) None Byte 

Output Relay Yn n: 0-360(octal) None Byte 
Timer PV Tn n: 0-255 None Word 
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Read/write range 
Register type Format 

Word No. Bit No. 
Data length 

16-bit Counter PV Cn n: 0-199 None Word 
32-bit Counter PV Cn n: 200-255 None Double Word
Data Register Dn n: 0-7999 None Word 
Special Data Register Dn n: 8000-8255 None Word 

Auxiliary Relay / Special Auxiliary Relay / Status Relay / Input Relay / Output Relay: 
must be the multiple of 8. 
 
2. Contacts 
 

Read/write range 
Contact type Format 

Word No. Bit No. 
Auxiliary Relay Mn None n: 0-3071 

Special Auxiliary 
Relay 

Mn None n: 8000-8255 

Status Relay Sn None n: 0-999 

Input Relay Xn None n: 0-377(octal) 
Output Relay Yn None n: 0-377(octal) 
Timer Flag Tn None n: 0-255 
Counter Flag Cn None n: 0-255 

 
C. Controller wiring 
RS-232 

DOP  
9 pin D-SUB male (RS-232) 

Controller  
8 pin Mini DIN male (RS-232) 

Controller  

RXD (2) (2) TXD

TXD (3)

GND (5)

(7) RXD

(3) GND

(6) GND 

 
 
 
 
 
 

Top View 
 

2 
3
67
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Matsushita FP PLC                                                     DELTA 
A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1. 
Controller station number: 238. 
Control area/state area: DT0 / DT10. 

 
B. Definition of controller Read/Write address 
1. Registers 

Read/write range  Register type Device 
Name Format Word No. Bit No. Data length

Internal Relay 0x00 WRn n: 0-875, None Word 
Special Internal Relay   900-910   
Link Relay 0x01 WLn n: 0-639 None Word 
External Input Relay 0x02 WXn n: 0-255 None Word 
External Output Relay 0x03 WYn n: 0-255 None Word 
Timer/Counter P.V. 0x04 EVn n: 0-2047 None Word 
Timer/Counter S.V. 0x05 SVn n: 0-2047 None Word 
Data Register 0x06 DTn n: 0-10239 None Word 
Link Data Register 0x07 LDn n: 0-8447 None Word 
File Register 0x08 FLn n: 0-32764 None Word 
 

3. Contacts 
Read/write range Contact type Device 

Name Format Word No. Bit No. 
Internal Relay 0x80 Rnb n: 0-875 b: 0-f 
Special Internal 
Relay   n: 900-910 b: 0-f 

Link Relay 0x81 Lnb n: 0-639 b: 0-f 
External Input Relay 0x82 Xnb n: 0-255 b: 0-f 
External Output 
Relay 0x83 Ynb n: 0-255 b: 0-f 

Timer Flag Contact 0x84 Tn None n: 0-2047 
Counter Flag Contact 0x85 Cn None n: 0-2047 

C. Controller wiring 
RS-232 
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DOP Series 

9 pin D-SUB male (RS-232) 
Controller 

5 pin Mini DIN male  
(RS-232 for FP0) 

Controller 
5 pin Mini DIN male

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(1) SG  
Top View  

 
RS-232 
 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller  
9 pin D-SUB male  
(RS-232 for FP1) 

Controller  
9 pin D-SUB male 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(7) GND

(4) RTS

(5) CTS  

Top View

 
Mirle FAMA SC                                                   DELTA 
A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 1. 
Controller station number: 0. 
Control area/state area: 40100 / 40200. 

 
B. Definition of controller Read/Write address 

1. Registers 
Read/write range Register type Device 

Name Format Word No. Bit No. 
Data Length

Output Registers 0x00 Wn n: 40001-50000 None Word 
Input Registers 0x01 Wn n: 30001-40000 None Word 

Input Registers is “read only”. 
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 2. Contacts 

Read/write range Contact type Device 
Name Format Word No. Bit No. 

Discrete Outputs 0x80 Bn None n: 1-10000 

Discrete Inputs 0x81 Bn None n: 
10001-20000

Discrete Inputs is “read only”. 
C. Controller wiring 
RS-232 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller  
9 pin D-SUB male (RS-232) 

Controller  
9 pin D-SUB male 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG  
Top View

 
Mitsubish FX/FX2N PLC                                                 DELTA 
A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 1. 
Controller station number: 0. 
Control area/state area: D0 / D10. 

 
B. Definition of controller Read/Write address 

1. Registers 
Read/write range  Register type Device 

Name Format Word No. Bit No. Data length

Auxiliary Relay 0x00 Mn n: 0-3064 None Byte 
Special Auxiliary 
Relay 

0x01 Mn n: 8000-8248 None Byte 

Status Relay 0x02 Sn n: 0-992 None Byte 
Input Relay 0x03 Xn n: 0-360(octal) None Byte 
Output Relay 0x04 Yn n: 0-360(octal) None Byte 
Timer PV 0x05 Tn n: 0-255 None Word 
16-bit Counter PV 0x06 Cn n: 0-199 None Word 
32-bit Counter PV 0x07 Cn n: 200-255 None Double 

Word 
Data Register 0x08 Dn n: 0-7999 None Word 
Special Data Register 0x09 Dn n: 8000-8255 None Word 
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Auxiliary Relay / Special Auxiliary Relay / Status Relay / Input Relay / Output Relay: it 
must be the multiple of 8. 
 2. Contacts 

Read/write range  Contact type Device 
Name Format Word No. Bit No. 

Auxiliary Relay 0x80 Mn None n: 0-3071 
Special Auxiliary 
Relay 

0x81 Mn None n: 8000-8255 

Status Relay 0x82 Sn None n: 0-999 
Input Relay 0x83 Xn None n: 0-377(octal)
Output Relay 0x84 Yn None n: 0-377(octal)
Timer Flag 0x85 Tn None n: 0-255 
Counter Flag 0x86 Cn None n: 0-255 

 
C. Controller Wiring 
RS-422 

DOP Series 
9 pin D-SUB male (RS-422) 

Controller  
8pin Mini DIN male (RS-422) 

Controller  
8pin Mini DIN male 

(RS-422) 
RXD+ (2) (7) TXD+

RXD- (1)

TXD+ (3)

(4) TXD-

(2) RXD+

TXD- (4) (1) RXD-

GND (5) (3) SG  

 1
4 
7

2 
3

Top View  

 
Modbus(Master) --- 984 RTU / ASCII mode                         DELTA 
A. HMI factory settings  

Baud rate: 9600, 7, EVEN, 1. 
Controller station number: 0. 
Control area/state area: 40100 / 40200. 

 
B. Definition of controller Read/Write address 

1. Registers 
Read/write range 

Register type 
Device 
Name 

Format
Word No. Bit No. 

Data length

Output Registers 0x00 Wn n: 40001-50000 None Word 
Input Registers 0x01 Wn n: 30001-40000 None Word 
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Input Registers is “read only”. 
 
 2. Contacts 

Read/write range  
Contact type 

Device 
Name 

Format 
Word No. Bit No. 

Discrete Outputs 0x80 Bn None n: 1-10000 

Discrete Inputs 0x81 Bn None 
n: 

10001-20000
Discrete Inputs is “read only”. 

 
C. Controller Wiring: Refer to B-1 for detail. 
 
Modbus(Slave) --- 984 RTU / ASCII mode                     
DELTA 
A. HMI factory settings  

Baud rate: 9600, 7, EVEN, 1. (ASCII) 
9600, 8, EVEN, 1. (RTU) 

Controller station number: 0. (no function) 
Control area/state area: W40100 / 40200. 
Note: 1. HMI station number is Slave station number. (default is 0) 

2. The relation between Modbus address and HMI internal registers. 
Modbus address  Data definition in HMI 

W40001 ~ W41024  $0 ~ $1023 

W42001 ~ W43024  $M0 ~ $M1023 

W44001  RCPNO 

W45001 ~ ...  RCP0 ~ RCPn 

B00001 ~ B01024  $2000.0 ~ $2063.15 

B01025 ~ B02048  $M200.0 ~ $M263.15 
 

B. Definition of controller Read/Write address 
1. Registers 

Read/write range Register type Format Word No. Bit No. Data length 

Output Registers Wn n: 40001-50000 None Word 
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2.Contacts 
Read/write range Contact type Format Word No. Bit No. 

Discrete Outputs Bn None n: 1-2048 
C. Controller Wiring: Refer to B-1 for detail. 
 
Modicon TSX Micro                                    DELTA 
A. HMI factory settings 

Baud rate: 9600, 8, ODD, 1. 
Controller station number: 2. 
Control area/state area: W0 / W10. 
Note: 1. HMI station needs to adjust to 1-8. 

2. PLC station and HMI station can be the same. 
3. You should set internal memory and relative parameters at PLC first. 

Otherwise, it cannot communicate except %S. 
 
B. Definition of controller Read/Write address 

1. Registers 
Register type Format Word No. Bit No. Data Size

WORD_DEVICE_ 
Internal 

%MWn n: 0-65534 None Word 

WORD_DEVICE_ 
System 

%SWn n: 0-127 None Word 

WORD_DEVICE_ Input %KWn n: 0-65534 None Word 
%KWn: only read. 
2. Contacts 

Contact type Format Word No. Bit No. 

BIT_DEVICE_ Internal %Mn:b n:0-65534 b:0-15 
BIT_DEVICE_ System %Sn  n:0-127 

BIT_DEVICE_ Internal1 %Mn  n:0-65534 
%Mn: b is bit address that corresponds to WORD_DEVICE_ Internal (%MWn). 
%Mn is PLC internal relay address. 
The read/write range of WORD_DEVICE_ Internal / BIT_DEVICE_ Internal 
depends on PLC used memory. 

C. Controller Wiring: It needs to use specific cable of Modicon Uni-Telway. (RS232) 
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Omron C Series PLC                                   DELTA 
A. HMI factory settings 

Baud rate: 9600, 7, EVEN, 2. 
Controller station number: 0. 
Control area/state area: DM0 / DM10. 

 
B. Definition of controller Read/Write address 

1. Registers 
Read/write range  Register type Device 

Name Format Word No. Bit No. Data length

IR area 0x00 IRn n: 0-511 None Word 
HR area 0x01 HRn n: 0-99 None Word 
AR area 0x02 ARn n: 0-27 None Word 
LR area 0x03 LRn n: 0-63 None Word 
TC area 0x04 TCn n: 0-511 None Word 
DM area 0x05 DMn n: 0-6655 None Word 

 
 2. Contacts 

Read/write range Contact type Device 
Name Format Word No. Bit No. 

IR area 0x80 IRnb n: 0-511 b: 00-15 
HR area 0x81 HRnb n: 0-99 b: 00-15 
AR area 0x82 ARnb n: 0-27 b: 00-15 
LR area 0x83 LRnb n: 0-63 b: 00-15 
TC area 0x84 TCn None n: 0-511 

 
C. Controller Wiring 
RS-232 
1:1 Host Link via RS-232C converter 

DOP Series 
9 pin D-SUB male (RS-232) 

Controller  
9 pin D-SUB male (RS-232) 

Controller  
9 pin D-SUB male 

(RS-232) 
RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(9) SG

(4) RS

(5) CS  
Top View

 
Siemens S7 200 PLC                                   DELTA 
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A. HMI factory settings 
Baud rate: 9600, 8, EVEN, 1. 
Controller station number: 2. 
Control area/state area: VW0 / VW10. 

 
B. Definition of controller Read/Write address 

1. Register 



 B-27

 
Read/write range Register type Device 

Name Format Word No. Bit No. 
Communication
-base address

Timer 0x00 Tn n: 0-255 None 0x1F (Word) 
Analog input word 0x01 AIWn n: 0-30 None 0x06 (Byte) 
Counter 0x02 Cn n: 0-255 None 0x1E (Word) 
Analog output word 0x03 AQWn n: 0-30 None 0x07 (Byte) 
Input Image 0x04 IWn n: 0-14 None 0x81 (Byte) 
Input Image 0x05 IDn n: 0-12 None 0x81 (Byte) 
Output Image 0x06 QWn n: 0-14 None 0x82 (Byte) 
Output Image 0x07 QDn n: 0-12 None 0x82 (Byte) 
Special Bits 0x08 SMWn n: 0-199 None 0x05 (Byte) 
Special Bits 0x09 SMDn n: 0-197 None 0x05 (Byte) 
Internal Bits 0x0A MWn n: 0-98 None 0x83 (Byte) 
Internal Bits 0x0B MDn n: 0-96 None 0x83 (Byte) 
Data Area 0x0C VWn n: 0-9998 None 0x84 (Byte) 
  (DBWn) (n: 0-9998)   
Data Area 0x0D VDn n: 0-9996 None 0x84 (Byte) 
Special S 0x0E SWn n: 0-99 None 0x04 (Byte) 
Special S 0x0F SDn n: 0-97 None 0x04 (Byte) 

 
2. Contacts 

Read/write range Contact type Device 
Name Format Word No. Bit No. 

Communication
-base address

Timer Bit 0x80 Tn None n: 0-255 0x1F 
Counter Bit 0x81 Cn None n: 0-255 0x1E 
Input Image 0x82 In.b n: 0-15 b: 0-7 0x81 
Output Image 0x83 Qn.b n: 0-15 b: 0-7 0x82 
Special Bit 0x84 SMn.b n: 0-200 b: 0-7 0x05 
Internal Bit 0x85 Mn.b n: 0-99 b: 0-7 0x83 
Data Area Bit 0x86 Vn.b n: 0-9999 b: 0-7 0x84 
Special S Bit 0x87 Sn.b n: 0-100 b: 0-7 0x04 

 
C. Controller wiring 
RS-232 
via RS232 / PPI Multi-Master Cable 
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DOP Series 

9 pin D-SUB male (RS-232) 
Controller 

9 pin D-SUB male (RS-232) 
Controller 

9 pin D-SUB male 
(RS-232) 

RXD (2) (2) RD

TXD (3)

GND (5)

(3) TD

(5) GND 
Top View

 
RS-485 
via PLC Program Port (RS-485) 

DOP Series 
9 pin D-SUB male (RS-485) 

Controller 
RJ-11 (RS-485) 

Controller 
RJ-11 (RS-485) 

RXD+ (2) (3)TXD/RXD+

TXD+ (3)

RXD- (1)

TXD- (4)

GND (5) (5)SG

(8)TXD/RXD-

 
Top View

 
Siemens S7 300 PLC (with PC Adapter)                                DELTA 
A. HMI factory settings 

Baud rate: 38400, 8, ODD, 1. (RS232). 
Controller station number: 2. 
(PLC station won’t be used when using by PC adapter. Therefore, only 1-to-1 
communication is allowed). 
Control area/state area: DBW0 / DBW20. 

Note:  
1. PLC DB memory (DBm.DBWn, DBm.DBDn, DBm.DBXn.b) must be 

open that HMI can read/write. 
2. The reason for using PC adapter: 

When communicating via PC adapter, it is profibus with 187.5 K 
baudrate at PLC side. Therefore, the network structure is rapider and 
steadier. 
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S7 300 S7 300 S7 300.....

HMI HMI HMI.....

RS485

RS232

Via PC adapter

 

 
When HMI communicates with PLC without PC adapter, the protocol 
will be complicated and it needs to lower PLC baud rate to 19200 due to 
HMI bard rate limit. Therefore, the efficiency of the network structure of 
S7 300 will be badly. 
 

3. Baud rate setting 
A. It needs to set PLC baud rate to 187.5 K and higher. (it cannot use 

19.2K) 
B. It needs to set baud rate of two sides when using PC Adapter 

a. "PLC side": as previous item it needs to set PLC baud rate to 187.5 
K and higher and cannot use 19.2K) 

b. "HMI side": it can select 38.4K or 19.2K by using switch on the 
cable. (only these two choices) 

c. HMI baud rate: it needs to set the baud rate of HMI side of PC 
adapter as previous item to 38.4K or 19.2K) (protocol setting is 
still 8, ODD, 1) 

d. There is no setting for PLC station and HMI station, so it won’t 
have the communication problem with error station setting. 

e. PC Adapter : 
1. The power LED will be lit once connect to PLC. (power supply 

of PC adapter is from PLC) 
2. If communication is OK, the communication LED will be blink. 

Otherwise, it will be dark. 
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B. Definition of controller Read/Write address 
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1. Register 
Read/write range 

Register type Format 
Word No. Bit No. 

Input Image IWn n: 0-65534 None 

Input Image IDn n: 0-65532 None 
Output Image QWn n: 0-65534 None 
Output Image QDn n: 0-65532 None 
Internal Bits MWn n: 0-65534 None 

Internal Bits MDn n: 0-65532 None 
Data Area DBm.DBWn n: 0-65534 m: 1-255 

 DBm.DBDn n: 0-65532 m: 1-255 
Data Area (DB10) DBWn n: 0-65534 None 

 DBDn n: 0-65532 None 

 VWn n: 0-65534 None 

 VDn n: 0-65532 None 

 
2. Contacts 

Read/write range 
Contact type Format 

Word No. Bit No. 
Input Image In.b n: 0-65535 b: 0-7 

Output Image Qn.b n: 0-65535 b: 0-7 
Internal Bit Mn.b n: 0-65535 b: 0-7 

Data Area Bit DBm.DBXn.b n: 0-65535 b: 0-7 

   m = 1-255 

Data Area Bit (10 DB) DBXn.b n: 0-65535 b: 0-7 

 Vn.b n: 0-65535 b: 0-7 

For all contacts when multiple copies: 
a. if it exceeds 65535 when increasing, it will be regarded as 0. 
b. If it is less than 0, it will be regarded as 655XX. 

 
C. Controller wiring 
RS-232 
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HMI connects to PC Adaptor 
DOP  

9 pin D-SUB male 
Controller  

9 pin D-SUB female  
Controller 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND

(8) CTS

(7) RTS

RTS (7)

CTS (8)  

 
 
 
 

Top view 

 
Taian TP02 PLC                                                          DELTA 
A. HMI factory settings 

Baud rate: 19200, 7, None, 1. 
Controller station number: 1. 
Control area/state area: V1 / V10. 

 
B. Definition of controller Read/Write address 
1. Registers 

Read/write range Register type Format Word No. Bit No. Data length

WORD_DEVICE_X Xn n: 1-384 None Word 
WORD_DEVICE_Y Yn n: 1-384 None Word 
WORD_DEVICE_C Cn n: 1-2048 None Word 
WORD_DEVICE_V Vn n: 1-1024 None Word 
WORD_DEVICE_D Dn n: 1-2048 None Word 
WORD_DEVICE_WS WSn n: 1-128 None Word 
WORD_DEVICE_WC WCn n: 1-912 None Word 

Note: WORD_DEVICE_X / WORD_DEVICE_Y / WORD_DEVICE_C: address must be 1 or 
the multiple of 16+1 

2. Contacts 
Read/write range 

Contact type Format Word No. Bit No. 
BIT_DEVICE_X Xn None n: 1-384 
BIT_DEVICE_Y Yn None n: 1-384 
BIT_DEVICE_C Cn None n: 1-2048 
BIT_DEVICE_SC SCn None n: 1-128 

BIT_DEVICE_SC: only read 1 bit for each communication. 
 

Pin1
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C. Controller wiring 
RS-422 

DOP  
9 pin D-SUB male (RS-422) 

Controller  
9 pin D-SUB male (RS-422) 

RXD+ (2) (3) TXD+

RXD- (1)

TXD+ (3)

(8) TXD-

(2) RXD+

(7) RXD-TXD- (4)  

 

RS-485 
DOP 

9 pin D-SUB male (RS-232) 
Controller  

RS-485(T/R+, T/R-) 

RXD+ (2) T/R+

TXD+ (3)

RXD- (1)

TXD- (4) T/R-  

 
YOKOGAWA ACE PLC                                                    
DELTA  
 
A. HMI factory settings 

Baud rate: 9600, 8, EVEN, 1. (ASCII code) 
Controller station number: 1. 
CPU NO. : 1. 
Control area/state area: D1 / D10. 

 
B. Definition of controller Read/Write address 
1. Registers 
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Register type Format Word No. Data Size 
WORD_DEVICE_X Xn n: 201-65464 Word 
WORD_DEVICE_Y Yn n: 201-65464 Word 
WORD_DEVICE_I In n: 1-16384 Word 
WORD_DEVICE_E En n: 1-4096 Word 
WORD_DEVICE_L Ln n: 1-65488 Word 
WORD_DEVICE_M Mn n: 1-9984 Word 
WORD_DEVICE_TP TPn n: 1-3072 Word 
WORD_DEVICE_CP CPn  n: 1-3072 Word 
WORD_DEVICE_D Dn n: 1-8192 Word 
WORD_DEVICE_B Bn n: 1-32768 Word 
WORD_DEVICE_W Wn n: 1-65499 Word 
WORD_DEVICE_Z Zn n: 1-512 Word 
WORD_DEVICE_V Vn n: 1-64 Word 
WORD_DEVICE_R Rn n: 1-4096 Word 
WORD_DEVICE_TS TSn n: 1-3072 Word 
WORD_DEVICE_CS CSn n: 1-3072 Word 

WORD_DEVICE_X / WORD_DEVICE_Y: the last two digits of address must be 1 or (the 
multiple of 16+1) and less than 65. 
WORD_DEVICE_I / WORD_DEVICE_E / WORD_DEVICE_L / WORD_DEVICE_M: address 
must be 1 or (the multiple of 16+1) 
WORD_DEVICE_X / WORD_DEVICE_Y / WORD_DEVICE_L / WORD_DEVICE_W: valid 
address is discontinuous. 
2. Contacts 

Contact type Format Label Bit No. 
BIT_DEVICE_X 0x80 Xn n: 201-65464 
BIT_DEVICE_Y 0x81 Yn n: 201-65464 
BIT_DEVICE_I 0x82 In n: 1-16384 
BIT_DEVICE_E 0x83 En n: 1-4096 
BIT_DEVICE_L 0x84 Ln n: 1-65488 
BIT_DEVICE_M 0x85 Mn n: 1-9984 
BIT_DEVICE_TU 0x86 TUn n: 1-3072 
BIT_DEVICE_CU 0x87 CUn n: 1-3072 

 
BIT_DEVICE_X / BIT_DEVICE_Y : the last two digits of address must be less than 65 
(1-64). 
BIT_DEVICE_X / BIT _DEVICE_Y / BIT _DEVICE_L : valid address is discontinuous. 
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Multiple copies: 
The next bit address of X264 is X301 (invalid addresses X265-X300 are 

skipped) 
The next bit address of X364 is X401. 
The address of Y is the same as X. 
(The WORD addresses of X and Y are also auto skip invalid addresses) 

 
C. Controller wiring 

It needs to use specific cable of YOKOGAWA ACE PLC. 
RS-232 

DOP  
9 pin D-SUB male (RS-232) 

Controller (6 pin) 
(RS-232 for YOKOGAWA) 

Controller 

RXD (2) (1) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND  
Top View 

 


